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Introduction to NetBackup User’s Guide -
Microsoft Windows

This guide is written for the end user and for the system administrator. It describes how to
use NetBackup to back up and restore folders that reside on a Microsoft Windows PC.

Organization of NetBackup User’s Guide - Microsoft Windows

The NetBackup User’s Guide - Microsoft Windows is structured to help you find the
information you need, quickly. The following table describes each major section:

Table 1.

Section

Description

Introduction

User Directed
Operations
Reference

System Administrators

NetBackup Commands

Provides an overview of NetBackup, describes how the end user
operates NetBackup, and describes technical terms and
concepts. Read this chapter to become familiar with the world of
NetBackup.

Explains how to use NetBackup to perform backup, archive, and
restore operations.

Describes the various windows, screens, and menus associated
with NetBackup.

Contains information important to the NetBackup system
administrator.

A detailed listing of commands available for use on the
NetBackup client.

Related Documentation

The following documents provide related information. For a more detailed listing of
NetBackup documents, refer to NetBackup Release Notes.

O NetBackup Installation Guide - PC Clients

Explains how to install NetBackup PC client software. The PC clients are Windows
NT/2000, Windows 95, Windows 98, Macintosh, OS/2 Warp, and Novell NetWare.

T e—
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Conventions

If you have a Unix server, refer to these documents:

O NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and
operating systems that are supported and operating notes that may not be in the
manuals or the online help.

NetBackup Datacenter System Administrator’s Guide - UNIX

Explains how to configure and manage NetBackup Datacenter on a UNIX system.
NetBackup BusinesServer System Administrator’s Guide - UNIX

Explains how to configure and manage NetBackup BusinesServer on a UNIX server.
NetBackup Troubleshooting Guide - UNIX

Provides troubleshooting information for UNIX based NetBackup products.

If you have a Windows NT/2000 server, refer to these documents:

O NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and
operating systems that are supported and operating notes that may not be in the
manuals or the online help.

NetBackup Datacenter System Administrator’s Guide - Windows NT/2000

Explains how to configure and manage NetBackup Datacenter on a Windows
NT/2000 server system.

NetBackup BusinesServer System Administrator’s Guide - Windows NT/2000

Explains how to configure and manage NetBackup BusinesServer on a Windows
NT/2000 server.

NetBackup Troubleshooting Guide - Windows NT/2000

Provides troubleshooting information for Windows NT/2000 based NetBackup
products.

Conventions

The following explains typographical and other conventions used in this guide.

viii
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Conventions

Type Style

Table 2. Typographic Conventions

Typeface Usage

Bol d fixed width |nput. For example, type cd to change directories.

Fi xed width Paths, commands, filenames, or output. For example: The default installation
directory is/ opt / VRTSxX.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your
file.

Sans serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.

Notes and Cautions

Note This is a Note and is used to call attention to information that makes it easier to use
the product or helps you to avoid problems.

Caution This is a Caution and is used to warn you about situations that can cause data
loss.

Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example,
you may have to hold down the Ctrl key before you press another key. When this type of
command is referenced, the keys are connected by plus signs. For example:

Press Ctrl+t

Command Usage
The following conventions are frequently used in the synopsis of command usage.
brackets [ ]
The enclosed command line component is optional.
Vertical bar or pipe (])

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command argl| arg2

Introduction to NetBackup User’s Guide - Microsoft Windows ix



Getting Help

the user can use either the argl or arg2 variable.

Getting Help

For updated information about this product, including system requirements, supported
platforms, supported peripherals, and a list of current patches available from Technical
Support, visit our web site:

http://ww. veritas.cont
For product assistance, contact VERITAS Customer Support.
US and Canadian Customers: 1-800-342-0652
International Customers: +1 (650) 335-8555
VERITAS Customer Support can also be reached through electronic mail at;

support @eritas.com
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Introduction 1

During installation, the NetBackup Browser is configured to work with a specific
NetBackup client. When a user starts an operation using the NetBackup Browser, the
browser software sends the appropriate messages to its designated NetBackup client. The
software on the NetBackup client then communicates with the server and handles the
client side of the operation.

NetBackup client software enables server directed backup, archive, and restore operations
on entire folders or individual files that reside on your NetBackup client. This software
also allows you to perform user directed backup, archive, and restore operations on your
NetBackup client, without logging into the NetBackup master server. Once you start a
user directed operation, the NetBackup process runs under the control of the NetBackup
master server. You request the service and the NetBackup master server manages the rest,
including storage and retrieval of data.

In NetBackup terminology, the system that requires the backup or archive is the
NetBackup client. The system that manages the storage and retrieval of the backup data is
called the NetBackup master server.




Backup and Archive Operations

Backup and Archive Operations

A backup saves copies of selected files and folders from a NetBackup client to a storage
device on a NetBackup master server or NetBackup media server.

An archive saves copies of selected files and folders to a storage device on a NetBackup
master server or NetBackup media server, then deletes the original files from the
NetBackup client.

User Directed Backups and Archives

You can perform a user directed backup during the time period scheduled by the
NetBackup system administrator. NetBackup allows you to select a combination of files,
folders with files, or entire drives to back up.

Files can be backed up through the NetBackup client interface or, if NetBackup Explorer
Extensions are installed and enabled, through Windows Explorer.

Server Directed Backups and Archives

The NetBackup administrator can schedule full backups and incremental backups that
occur automatically and unattended, under control of the NetBackup master server. Full,
incremental and true image backups can only be performed by the NetBackup master
server. When properly scheduled, the server directed backups will meet most of your
backup requirements.

Note In previous versions of NetBackup for Windows, server directed backups could be
only partially successful since some applications retain locks on files when left
open. NetBackup DataCenter is packaged with OTM (Open File Manager), which
resolves this problem. If OTM is disabled, be sure to shut down all applications on
the NetBackup client before proceeding with server directed backups.

OTM is a separately priced option for BusinesServer.

Full Backup

When the NetBackup master server is configured to perform a full backup, NetBackup
backs up all files in a specified folder or drive to a storage unit. The archive bit is cleared
as each file is backed up. If the full backup fails, NetBackup will attempt another full
backup at the same time each day until successfully completed. A successfully completed
backup will include all files.
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Backup and Archive Operations

Cumulative-Incremental Backup

When the NetBackup master server is configured to perform a cumulative-incremental
backup, NetBackup backs up all files that have changed since the last successful full
backup.

Cumulative incremental backups can be configured to use either the datetime stamp or
the archive bit. If the datetime stamp is used, the cumulative-incremental backup includes
all files with a datetime stamp that are more recent than the last full backup. If the archive
bit is used, the cumulative-incremental backup includes all files that have their archive bit
set. Archive bits are not cleared on cumulative-incrementals. Refer to “General Property
Sheet” on page 54 for more details on performing incremental backups with archive bits.

Differential-Incremental Backup

When the NetBackup master server is configured to perform a differential-incremental
backup, NetBackup backs up all files that have changed since the last successful backup.

Differential incremental backups can be configured to use either the datetime stamp or the
archive bit. If the datetime stamp is used, the differential-incremental backup includes all
files with datetime stamps that are more recent than the last backup, full or incremental. If
the archive bit is used, the differential-incremental backup includes all files that have their
archive bit set. Archive bits are cleared on differential-incrementals if the file is
successfully backed up. Refer to “General Property Sheet” on page 54 for more details on
performing incremental backups with archive bits.

True Image Backup

A True Image Backup takes place when the True Image Restore Information attribute has
been set on the NetBackup master server. When this attribute is set, NetBackup collects
additional information necessary to restore a folder to exactly what it was at the time of
the full backup or incremental backup.

Only those backups, performed with the True Image Recovery Information attribute set
on the NetBackup master server, can be used for the true image restore. For complete
details, refer to the NetBackup System Administrator’s Guide - UNIX or the NetBackup
System Administrator’s Guide - Windows NT/2000.
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Restore Operations

Restore Operations

A restore reads backups from the storage device on the NetBackup master server or the
NetBackup media server and restores them to the NetBackup client. NetBackup allows
you to select a combination of files, folders with files, or entire drives to restore.

File Permissions and Open Files

File permissions require write permission on the destination folder in order to restore a
file. A file will not be restored when a file with the identical name is open on the
NetBackup client.

Access Control Lists

If the access control list to a file on a Windows NT/2000 system has changed since the file
was backed up, the file will be restored by NetBackup as follows:

0O A user that has been granted access to the file since the backup will not have access to
the file after the restore

0O A user that has had access to the file removed since the backup will again have access
after the file is restored

If the access control list has changed since the backup, it will be restored to what it was at
the time of the backup.

Server Directed Restore

The administrator on the NetBackup master server can direct restores to any NetBackup
client (regardless of which NetBackup client the files came from). Refer to “Alternate
Client Restores” on page 82 for details.

A client can prohibit server directed restores by clearing the Allow Server-Directed
Restores option on the General property sheet.

User Directed Restores

You can start a restore operation at any time. Restored folders and drives include all files
that were backed up or archived during a range of backups. NetBackup is also able to
perform an alternate-client restore and a true image restore.
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View Status

Alternate Client Restore

With the necessary permissions and configuration, users can browse the NetBackup
database for files backed up by another NetBackup client and restore files to their own
computer.

System administrators can direct restores to the client that originally backed up the files or
to another (alternate) client. This type of restore must be performed on the master server
and is called a server directed restore.

Refer to “Alternate Client Restores” on page 82 for details on using the NetBackup
Browser on the NetBackup server for alternate client restores.

Restore from True Image Backup

A Restore from True Image Backup can be performed only on server directed backups and
archives in which the True Image Restore Information attribute has been set. Refer to the
NetBackup System Administrator’s Guide - UNIX or the NetBackup System Administrator’s
Guide - Windows NT/2000 for details.

A true image restore of a folder, by default, restores the folder so its contents are exactly
what they were at the time of the most recent server directed full backup or incremental
backup. Files deleted prior to the specified backup are not restored.

During a true image restore of a folder, NetBackup determines which files belong in the
folder and then reconstructs it by using the most recent backup of these files.

NetBackup does not allow a true image restore that is based on the time of a user
operation. However, NetBackup does use the backups from a user directed operation if
they are more recent than the latest server directed full backup or incremental backup.

A true image restore is the best choice if, for example, you have recently cleaned up a
folder by deleting unwanted files and now want to restore the latest version without
having to repeat your cleanup. It is also possible to restore the true image of an earlier
version of a folder.

View Status

You can view, print and delete status reports.

File Permissions Required By NetBackup

You need backup privileges to back up or archive a file. Without backup privileges, you
must have read access to a file in order to back up the file and read and delete access to a
file in order to archive the file (since the archive operation removes the file from the disk).

Listing and restoring files and directories require the following permissions:
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File Permissions Required By NetBackup

O To list or restore files in a directory owned by someone else, you must have restore
privileges. Without restore privileges, you can only restore from a user directed
backup you have performed (unless Free Browse is turned on, see “Free Browse” on
page 79 for more details).

O Torestore afile to its original location, you must have write access to the file (if the file
exists), or to the directory (if the file does not exist).

The following table shows how NetBackup restores files in various situations (for
example, if a copy of the file or directory already exists).

Table 3. File Permissions

Type of Restore Attempted

Results

Restore a file that already exists
and overwrite the existing file.

Restore a file that already exists
and not overwrite the existing
file.

Restore a file that doesn’t exist.

Restore a file when a directory
exists with the same name as the
file.

Restore a directory when afile
exists with the same name as the
directory.

Restore a file in a directory that
does not exist.

If you have restore privileges, NetBackup restores the file and sets
file ownership to the same owner as the backup image.

If you do not have restore privileges, NetBackup restores the file
only if you have write access to it. In a case where the file is read
only, but you have write access to the parent directory, NetBackup
removes the file and restores the backup image with the original
owner as the owner.

Whether you have restore privileges or not, NetBackup does not
restore the file and places a message in the progress log.

Whether you have restore privileges or not, NetBackup restores the
file and sets file ownership to the same owner as the backup.

Whether you have restore privileges or not, NetBackup places a
message in the log file indicating that the directory will be replaced
with the file after the next system reboot. After the system boot, the
directory is not replaced and the file is restored with a temporary
filename in the parent directory of the directory. This occurs only
when overwrite existing files is enabled. The log file will indicate
the name the file was given and to which directory it was restored.

The directory will not be restored.

NetBackup creates the directory with the owner set to the account
used to start the NetBackup client service. The file is then restored
in the same manner as one that does not exist (see above).
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User Directed Operations ?

This section provides step-by-step instructions on using the NetBackup Browser to
perform backups, archives and restores. For information on scheduled backups and other
server directed operations, see the NetBackup System Administrator’s Guide - UNIX or the
NetBackup System Administrator’s Guide - Windows NT/2000.

Start the Browser

1. Click the Windows Start menu.

2. Click Programs, VERITAS NetBackup, NetBackup .

The Backup, Archive, and Restore - NetBackup window will appear.

Feady él

v Toolbar

For most operations, it is easier to use the buttons on the toolbar. The horizontal toolbar on
the Backup, Archive, and Restore - NetBackup window opens windows to browse for
backups or restores and to view the progress report of a NetBackup operation.

The NetBackup Backup window or the NetBackup Restore window has a vertical toolbar
with buttons for frequently used menu commands. Clicking a button on a toolbar has the
same effect as using the menu command. Any action initiated by the buttons on the
vertical toolbar only pertains to the window it is associated with.




Start the Browser

v Helpful Hints

Marking Files and Folders

g
g

To mark a file for backup or restore, select the checkbox to left of a file.

To mark a folder for backup or restore, select the checkbox to the left of a folder. A
check mark will appear in the box. A slash mark in the box indicates only some of the
files or subfolders within that folder are marked.

To mark all the files (and folders) that currently appear in the <variable>Contents of
'<folder>" pane, click Mark Displayed Files from the Edit menu.

Unmarking Files and Folders

a
a

To unmark a file, clear the checkbox to the left of the file.

To unmark a folder, and all its files and subfolders marked within that folder, clear the
checkbox to the left of the folder.

To unmark all files and folders that currently appear in the <variable>Contents of
'<folder>" pane, select Unmark Displayed Files on the Edit menu.

To unmark all previously marked files and folders, select Unmark All on the Edit
menu. You can also use the Unmark All on the NetBackup Backup window or
NetBackup Restore window toolbars.
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Perform Backups or Archives

Perform Backups or Archives

This section includes a tutorial. It walks you through a simple backup of the r eadne. t xt
file installed in the NetBackup folder. You can back up a file either through the NetBackup
Browser or through Windows Explorer.

Backing Up a File Through Windows/Windows NT Explorer

Note Explorer Extensions must be enabled in order to be able to back up files through

Windows Explorer. To enable this feature, open NetBackup and on the Actions
menu select NetBackup Explorer Extensions.

3.

4.

5.

Open Windows/Windows NT Explorer.

Right-click on the file (or folder) you wish to back up.

a. Openthe Program Fi | es\ VERI TAS\ Net Backup folder.

b. Findthe Readnmed . t xt file and right-click on it.

Click Backup Now.

To show the progress of the backup operation, Automatically Show Progress Log.

To begin the backup operation, click Yes.

Backing Up a File Through the NetBackup Browser

1.

Start NetBackup as described in “Start the Browser” on page 7. The Backup, Archive,
and Restore - NetBackup window should appear.

Open the NetBackup Backup window.

There are two ways to open the NetBackup Backup window.
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Perform Backups or Archives

O Click Select Files and Folders to Backup on the Actions menu.

Eile SOy View Help
_@S @ Select Files and Folders to Backup...
Select Files and Folders to Restore. ..

Configure...

Specify HetBackup Machines...

& Yiew Status...

Open a Mew Backup ‘Window él

or

O Click Select for Backup on the Backup, Archive, and Restore - NetBackup
window vertical toolbar.

B Select for Backup | B Select for Restore - | G2 View Status

The NetBackup Backup window will appear.

_@ Select for Backup | EFSelect for Restore + | By Wiew Status | @
All Folders Contents of C:%
O5 A Name | Attributes | Size | Timi «
o O=E LI AdobePS d-— 0 42
Backup O=0D [ 27 download d— 0 172,
O=¢E JCIENGLISH d--- 0 122
:E: O&F O CIWMOMITOR d--- 0 122
Unrnark 096 1 My Documents d--- 0 172
Al O=H OCaPen d-- 0 S5/
| E P (2 Program Files d--r o 172
OFs .
Frevviaw [] o Network (22 Public d 0 22,
List B0 @p Registiy O[CaReal d--- 0 41,
O [CIRECYCLED dsh- 0 122
OCaTEMP d--- 0 272
O users d--- o 5721
O CavERITAS d--- 0 4721
O CavRTSwland d--- 0 981,
O CawINDOwWsS d--- 0 172~
<« | »
4
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Perform Backups or Archives

3. Mark afile to backup.

a. Openthe Program Fi | es\ VERI TAS\ Net Backup folder.

b. Find the Readnmed . t xt file and select the checkbox to the left of the item.

E File Actions Edit Yiew Backup Window Help = |ﬁ'|1|
7 Select for Backup | B3, Select for Restore ~ | 2 View Status | &
g All Folders Contents of C:\Program Files\VERITAS\NetBackup
= =[] Paint Shop Pro & (] [Hame [attibu.. [ Sice | Time Modiied |
e O Pen O (Catin d- 0 3/28/00 3:06:56 ...
200 Plus! 01 22 Client g 0 320031230
— 2-0]@ Quadralay O@d e 0 3/2B/00 30656 .
. 88 g:':'amec QR i 0 3/28/00312:42 .
+-C1(1 Uninstall Information O logs d-- 0 3/28/00 2:06:56 ...
7101 VERITAS OCaTemp d-- 0 3/28/00 214:48 ..
C1C1 Help O var d-- 0 3/28/00 31240 ..
DD libs E FeadmeCl txt B96E  12/9/99 3:03:00 ..
o E. |:| wersion. bt 94 32300 21342
+-[] 1 Volmgr
1 Windows Media Player
[ Windows Meszaging
+-[] 1 Windows NT
00 winZip
+-[][C1 PSFONTS
13 Public
+-[][C1 RECYCLED
+-[](1 RECYCLER |
Feady él
4. Start the backup operation.
a. Click Start Backup of Marked Files on the Backup menu.
E File Actions Edit View Window Help 18] =l
B Select for Backup | B Select for Specily Class and Schedule |
All Folders g Start Backup of Marked Files...
g #0028 A
tart S FA=cC
Backup -] (21 AdobePS
s | D download ([0 o
or
—
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Perform Backups or Archives

Click Start Backup on the NetBackup Backup window vertical toolbar.

Start
Backup

o[
LETY
Unmark.
All

Preview
List

The Specify Backup Options dialog box will appear.

Specify Backup Options m
% Backup to MetBackup server: Iwindows j

General Options |

Items marked to be backed up:

Mame |
C:\Program Files\WERITAS \MetB ackup'\Readme. bt

[ Archive files [delete files after successhul backup)

Keyword phrase to azzociate with the backup [optional]

Start Backup I LCancel | Help |

b. Review your selections in the Name list box.

0O Ifthe Readmed . t xt file is not listed, click Cancel.
This will return you to the NetBackup Backup window. Repeat step 3.
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Perform Backups or Archives

Enter a keyword in the Keyword phrase to associate with the backup (optional)
box. In this example use t est as the keyword.

Specify Backup Options m
% Backup to MetBackup server: Iwindows j

General Options |

Items marked to be backed up:

Mame |
C:\Program Files\WERITAS \MetB ackup'\Readme. bt

[ Archive files [delete files after successhul backup)

Keyword phrase to azzociate with the backup [optional]
Itest

Start Backup I LCancel Help

Click Start Backup.

The backup request goes to the NetBackup master server. A NetBackup message
will indicate that the backup was successfully started.

@ The backup was successfully initiated.

Do you want to view the progress of the backup?

e. Click Yes on the NetBackup Message dialog box to open the View Status dialog

box.

The View Status dialog box allows you to view the progress report of a
NetBackup operation. For more information see “View the Status of a User

Directed Operation” on page 21.

Note The NetBackup operation may take a few minutes to complete. You can close the
NetBackup Browser after starting a backup operation. NetBackup will continue the

backup operation in the background.

Backing Up Shared Folders

For information on backing up shared folders, refer to the “Backup Network Drives” topic
in the NetBackup System Administrator’s Guide.

Chapter 2, User Directed Operations
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Perform Restores

This section walks you through a simple restore of the Readrmred . t xt file backed up in
“Perform Backups or Archives” on page 9 of this manual.

1. Start NetBackup as described in “Start the Browser” on page 7.

2. Open the NetBackup Restore window.
There are two ways to open the NetBackup Restore window.

O On the Actions menu, click Select Files and Folders to Restore, then
from Backup.

E File m Edit View HRestore Window Help

_@Selec _@ Select Files and Folders to Backup... I |
Select Files and Folders to Bestore 4 from Backup. ..

Configure...

from Raw Partition Backup...

18|
from Archived Backup... !
3

Searc Specify NetBackup Machines._..
Backups from True Image Backup...
@ View Status._
from Backup as a Proxy -
Start Stop from Archived Backup as a Proxy... L4
Restore All Folders Contents from Raw Partition Backup as a Proxy...
o =-[] E) pansy Hame | from True Image Backup as a Proxy... M odifie
o #J=cC =t 9/9/1999 10:28:25 PM  d-1 0
or

O On the horizontal toolbar, click the arrow on the Select for Restore button and
select Restore from Backup.

E File Actions Edit View Hestore Window Help 18] =l

B Select for Backup | B Select for Restore| - | G2 View Status | &
1999  Hestore from Archived Backup... -
Search Sep Restore from Baw Partition Backup...
Backups 9 Restore from True Image Backup... 30 29 28 27 26
[ [ [ [ [ [
= Restore from Backup as a Proxy... S = =
Start 4 I Rest from Archived Backup as a Proxy... 4
Restore All Folders Restore from Raw Partition Backup as a Proxy...
ofie Restore from True Image Backup as a Proxy... I ‘Attributes I Size I Time Modifie
~ u NetBackup User’s Guide - Microsoft Windows
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The NetBackup Restore window will appeatr.

!__-5 Backup. Archive, and Restore - NetBackup - [Restore: Server: windows Source Client: pansy Destina... !Elm

E File Actions Edit Yiew RBestore Window Help - |ﬁ'|1|
_@Select for Backup | Select for Restore + | G2 View Status | @
MetBackup History
1999
Search Sep Aug
Backups 9 8 7 6 5 4 3 2 1 31 30 29 28 27 26 2% A
= @ = & &
€ @
Shart )
Restare
ol
EET
Unmark.
All < | _,I
All Folders Contents of "pansy’
F'r?_\_u'iztew =-[1] 2 pansy Time Backed U
N +J=C C=C 9/9/199910:28:25 PH d-r 0
by #J=D =D 9/9/199910:28:25 PM d-r 0
Bhr;ef #J=E O=E 9/8A199911:02:59 PH d-r 0
ign +[= 6 =6 9/9/199910:28:25 PM d-r 0
Wiew
)
Shaw Al < ] D
Feady él

There may be a delay before lists appear in the NetBackup Restore window.
NetBackup has to obtain the file information from the catalogs on the NetBackup
master server.

If files or folders do not appear in the NetBackup Restore window, it can be due to one
of the following:

0O Perform Default Search is not enabled. In this case, start a search manually by
clicking Search Backups on the Restore menu. Or to display the files in a backup,
click a backup image.

O The NetBackup server does not have any backups of files for your client. Ensure
that the client is connecting to the correct server (see “Servers Property Sheet” on
page 61). Also, ensure that you are using the correct client name (see “General
Property Sheet” on page 54). You can also refer to the title bar. If these settings are
correct and you believe there are backups available, contact your system
administrator.

3. Select a file to restore.

If you know the backup image (or the range of images) you can select it from the
NetBackup History pane without going through the Search Backups dialog box.
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In this tutorial, we are going to use the Search Backups feature to restore the
Readned .t xt file backed up in the “Perform Backups or Archives” on page 9.

Tip Before initiating a search, collapse the tree in the All Folders pane as much as
possible. NetBackup will expand the tree to the folders that match your search
criteria.

a. Open the Search Backups dialog box.
There are two ways to open the Search Backups dialog box.

0O Click Search Backups on the Restore menu.

Window Help

B Select for Backup | eler iji] Search Backups... |
@ Start Restore of Marke® Files...

Select Restore Type. ..

or

O Click Search Backups on the vertical toolbar.

Search
Backups

Start
Restare

The Search Backups dialog box will appear.

b. Type the path to the backed up file in the Search Folder box. For this example we
will enter C: \ Progr am Fi | es\ VERI TAS\ Net Backup\ .
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c. Typetest inthe Keyword Phrase (Optional) box.

Search Backups B

Search Folder:
Ic:\Program Filez'Weritaz\Metbackup

W Perform case-insensitive search

Kepword Phraze [optional):

Itesﬂ

Start Date:
|3£2?£DD 8:19:37 P LI
End Date:
IBJSDJDD 7:24:55 PM LI

Search I Cancel | Help |

d. Press Search. NetBackup will display the tree to the lowest levels of folders which
contain files that were backed up.

E File Actions Edit View Hestore Window Help —18]=l
7 Select for Backup | 3, Select for Restore - View Status | &
MetBackup History
2000
Mal
28 27 25 24 23 2 M 20 19 18 17 16 15 14 -
. . e & . e & l e & & & ¢ & & & & ¢
" [All Folders Contents of 'C:\Program Files\VERITAS\MetBackup’
=-[] &2} pansy +| [ Mame | Time Back... | Attiib... | Size | Time Modif... [ ]
=d=cC § O logs 3/28/007.. d-- 0 3728700 3.
=[] Program Files O Temp 32700 8. d- 0 3/23/007-...
=04 éETS m  (DQver 3/28/00 7:... d— 0 3/28/003:...
=0 |:| [Z] ReadmeCltxt 3/28/007-... - 5966 1279799 3:...
| = '“_lLl OE] version.txt 3/28/007.... - 94 3/23/00 2:...
4 » -
4
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Select the checkbox to the left of the ReadneCL. t xt file.

E File Actions Edit View Hestore Window Help —18]=l
7 Select for Backup | 3, Select for Restore -~ View Status | &
MetBackup History
2000
Mal
28 27 2% 25 24 23 2 2 20 19 18 17 16 15 14 -
.....3333333331
]
<« | ol

All Folders

Contents of 'C:\Program Files\VERITAS\MetBackup’

= .Q C
--[#] C1 Program Files
--[#] L1 VERITAS

BN PR Not ack

Dghin -
<« ]

Feady

Mame | Time Back... | Attrib. . |

O3 togs 3/28/00 7:... d— 0
O3 Temp 3/27/008:... d-—- 0
O var 3/28/00 7. d-- 1}
E]EfReadmeC]. tet JRTRL Y11 I A— 5966
[E] version. txt 3/28/00 7-... 94

Size I Time Modif... I AI
3728400 3.
3723700 F-_.
3728400 3.
1279499 3.
3723700 2-__.

-

4

Notice that the checkboxes in the All Folders pane have a slash in them.
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4. Start the restore operation.

a. Open the Restore Marked Files dialog box.
There are two ways to open the Restore Marked Files dialog box

O Click Start Restore of Marked Files on the Restore menu.

E File Actions Edit View Window Help —18]=l
7 Select for Backup | 3, Sele @ Search Backups... | &

@ MetBackup History Start Bestore of Marked Files...
f— 2000 Select Restore Type. ..

=l Mal
29 28 27 2% 25 24 23 2 A 20 19 18 17 16 15 14

i%:llllleeeeeeeeee
e
| >|

<1

- 7 All Folders Contents of 'C:\Program Files\VERITAS\MetBackup’
«| [ Hame | Time Back... | Attiib... | Size | Time Modif... [ ]
O logs 3/28/00 7-... d— 0 3/28/00 3:...
=10 Program Files O Temp 3/27/00 8:... d-- 0 3/2300 7.
| =110 VERITAS O var 3/28/00 7-... d— 0 3/28/00 3:...
SR NetBack EIEfReadmeC]. tet JRTEYI1 I — 5966 12/9/99 3.
. M [S] |hm_'|L| OE] version.txt 3/28/00 7-... - 94 3/23/00 2:...
Start Restore of Marked Files él

or
O Click Start Restore from the vertical toolbar.

Search
Backups

Start
Restore

Unmark.
All

The Restore Marked Files dialog box will open.
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b. Select the Overwrite the existing file checkbox.

C.

Restore Marked Files B

Restore Marked Files |

r~ Restare Destination Chaoice
@& Restore evenything to its original location

 Restore evenything to a different location [maintaining existing structure):
Source:

Destination:

I Browse... |

€ Restore individual folders and files to different locations [double-click to madify):

Source | [ estination I Time Bacl

C:\Program Files\YERITAS M etB ackuphR eadmelCl bt 34284007

<« | i
r Restore Option:

I the destination file already exists:

porary filename

7 Do nok restore the fil

Start Hestorel Cancel | Help |

Click Start Restore to start the restore operation.
A NetBackup message will indicate that the restore was successfully started.

@ The restore was successfully initiated.

Do you want to view the progress of the restore?

Click Yes on the NetBackup Message box to open the View Status dialog box.

The View Status dialog box allows you to view the progress report of a
NetBackup operation. For more information see “View the Status of a User
Directed Operation.”

Note The NetBackup operation may take a few minutes to complete. After starting a

restore operation, you can close the NetBackup browser and perform other tasks on
your computer. NetBackup will continue the restore operation in the background.
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View the Status of a User Directed Operation

1. Open the View Status dialog box to check the progress report.

There are two ways to open this dialog box.

O Click the View Status button on the toolbar in the Backup, Archive, and Restore -

NetBackup window.

or

O On the Actions menu click View Status.

—m

- Selected Operation:

&8 View Status [gla) !EI m
Operation Type | Time Requested Operation Status | | Close |
3tord 2/17/99 11:00:55 AHES
Backup 8/16/99 5:38:29 PM Successful Delete |

Help |

Refresh Rate [seconds): Im ﬂ
il

[T Werhose

Progress:

11:01:16 [61351.001) INF
11:04:26 [61351.001) INF

11:01:15 (61351.001) INF -

TAR STARTED [+]

- aiting for mount of media id BOD30 on server carat,

- W aiting for pogitioning of media id BOO30 on server carrat.
11:05:18 [61351.001) INF -
11:05:26 [61351.001) INF -
11:05:26 [61351.001) INF -
11:05:26 [61351.001) INF -
11:05:26 [61351.001) INF -

Beginning restore from server camot to client pansy.
TAR EXITING WITH STATUS =0

TAR RESTORED 1 0F 1 FILES SUCCESSFULLY
TAR KEPT DEXISTIMG FILES

TAR PARTIALLY RESTORED OFILES

11:05:28 [E1357 xux] IMF - Status = the requested operation was successfully completed,

K1

The status will appear in the top pane under the Operation Status column.

2. Select the operation that you want to check the progress of.

3. Click Refresh.

The lower pane will reflect the progress of the item selected in the top pane.

4. Select a refresh interval. The default setting is 0 seconds, which means the status will

not be automatically refreshed.

5. By default the progress file is displayed in an abbreviated form. If you wish to view
the entire contents of the progress file, select Verbose.

Chapter 2, User Directed Operations



View the Status of a User Directed Operation

The NetBackup operation is finished when the Status changes to Successf ul . If
NetBackup was unable to back up or restore all of the requested files, a status code
appears a few lines before the end of the progress report. The NetBackup Troubleshooting
Guide - UNIX or the NetBackup Troubleshooting Guide - Windows NT/2000 list the meaning of
the final status code.

~ 22 NetBackup User’s Guide - Microsoft Windows



Advanced Restore Procedures

Advanced Restore Procedures

The following is a detailed explanation of how to perform advanced restores.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed
up from the time of the last full backup to the most-recent backup. If the client belongs to
more than one ‘class, the default display starts with the last full backup that occurred first.
For example, assume that the client belongs to ClassW1 and ClassW2. Full backups occur
for both of them—ClassW1's most recent full backup occurred on Feb. 2 and ClassW2's
most recent full occurred on Feb. 10. The display shows files ranging from the time of the
ClassW1 full backup on Feb. 2.

The default range will satisfy the majority of your needs to restore files. There will be
times, however, when you must restore a file that was not backed up during the default
time period. For example, a file that was deleted prior to the last full backup does not
appear in the default display. In this case, you must use the NetBackup History pane to
select a backup that contains the file.

Searching for Files to Restore
1. Open the NetBackup Restore window.

2. Click Show All Backups on the View menu to display all copies of files and folders
from all of the backups. Show Most Recent Backup will display the most recent copy
of the file or folder.

3. Select the images, from the NetBackup History pane, that you believe contain the files
and folders you want to restore.

4. Narrow the search range as much as possible to speed up your search.
0O Select a specific backup image in the NetBackup History pane.

0O To select a range of backup images, select the first one in the range and then, while
holding the Shift key, select the last one in the range. In this case, NetBackup
searches all the backup images in the selected range. The range search will start
after the second image is selected.

0O Cancel previous selections by selecting another backup.

1. A NetBackup class defines the backup policies for a specific group of one or more clients that have similar
backup requirements. The NetBackup system administrator configures the class for your PC.
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5. Click Search Backups on the Restore menu to open the Search Backups dialog box.

Search Backups B

Search Folder:
Ic:\Program Filez'Weritaz\Metbackup

W Perform case-insensitive search

Kepword Phraze [optional):

Itesﬂ

Start Date:
|3£2?£DD 8:19:37 P LI
End Date:
IBJSDJDD 7:24:55 PM LI

Search I Cancel | Help |

Enter the search path that you want NetBackup to use in its search for files and
folders.

The number of files you can list during a search is limited by the amount of free
memory you have on your computer. If you reach the limit, modify the date or file
path parameters to narrow the scope of the search.

By default, the Search Backups dialog box shows the information for the folder that is
currently selected in the All Folders pane of the NetBackup Restore window. See
“Search Backups Dialog Box” on page 71 for more information.

Click Search to start the search. When the search is complete, NetBackup updates the
NetBackup Restore window.

Restore an Earlier Version of a Folder or File

This procedure will restore all files that were backed up during the range of backup dates.
This includes files that were deleted from your online folder after they were backed up. If
you do not want the deleted files, refer to “Restoring a True Image of a Folder” on page 25.

1.

2.

Open the NetBackup Restore window.

Open the backup NetBackup History pane.

If the NetBackup History pane is not open, click and drag the horizontal splitter bar
down.
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3. Inthe NetBackup History pane, select backup images for the dates of the backed up
files or folders you want to restore.

NetBackup will search the backup images, and display the contents of the backup
images in the All Folders and <variable>Contents of '<folder>" panes.

O To restore a version of a folder or file that existed prior to the last full backup,
select only the backups that include the desired version of the folder or file.

O To further narrow your search for a specific folder, file or keyword, go to step a.

a. On the Restore menu, click Search Backups to open the Search Backups dialog
box.

b. Enter afilename or keyword.

c. Click Search to start the search. When the search is complete, the NetBackup
Restore window is updated.

4. Select the folder you want to restore in the All Folders pane of the NetBackup Restore
window.

5. Mark the files or folders you need in the <variable>Contents of '<folder>’ pane. By
default, NetBackup restores files and folders to their original location.

6. Click Start Restore of Marked Files on the Restore menu.

Restoring a True Image of a Folder

Note You can restore a true image of a folder only if the NetBackup class that is backing
up your files and folders is configured to collect true image restore information
prior to backup. If in doubt, ask your NetBackup administrator.

What Is a True-Image Restore?

A true-image restore of a directory, by default, restores the directory so its contents are
exactly what they were at the time of the most recent automatic full or incremental
backup. Files deleted prior to the specified backup are not restored.

A true image restore is the best choice if, for example, you have recently cleaned up a
directory by deleting unwanted files and now want to restore the latest version without
having to repeat your cleanup. It is also possible to restore the true image of an earlier
version of a directory.
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Example of a True Image Restore

To illustrate the concept of a true image restore, consider the following table, which shows

the contents of a directory named:

c:\doc

during a series of backups performed between 12/01/95 and 12/04/95.

Day 12/01/95  12/02/95 12/03/95  12/04/95 12/04/95
Type of Backup  (Full) (Incr) (Incr) (User Back) (Incr)
filel filel filel filel filel
file2 file2 file2 file2 file2
dirA/ffileA  dirAffileA dirAffileA dirAffileA -
dirB/fileB - - - -
file3 - - - -
dirCffileC -
file4 file4

Assume that you are going to restore the most recent version of the directory.

ad

If you perform a standard restore, NetBackup will restore all files and subdirectories
that were backed up during the time period from 12/01/95 (last full backup) through

If you restore a true image backup, NetBackup restores only the files and directories
that existed at the time of the incremental backup on 12/04/95.

12/04/95.
filel
file2
dirAfileA
dirB\fileB
file3
dirQfileC
filed
filel
file2
filed

NetBackup does not restore anything deleted prior to the 12/04/95 incremental

backup.
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Notice that the restored directory does not include the dirA and dirC subdirectories,
even though they were backed up on 12/04/95 with a user-directed backup.
NetBackup did not restore these directories because they did not exist at the time of
the incremental backup that was the reference for the true image restore.

True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that
are currently in the directory but not in the true image restore backups.

Using the previous example, if you had created a file5 after the incremental backup
occurred on 12/04/95, but before doing the restore, then the contents of the directory after
the restore would have been:

filel
file2
filed

file5 (thisisthe new file that is not in any of the backups)

True-Image Restore Procedure

1. From the Restore menu, choose Select Restore Type and point to True Image
Backups.

If yougetaNo Entity Found message at this point, notify the administrator. The TIR
option on the NetBackup server must be set before you can perform a true image
restore. A backup with the TIR option set needs to exist before a TIR restore can
happen.

2. Inthe All Folders pane of the NetBackup Restore (True Image) window, double-click
the parent of the folder you want to restore.

The double-click updates the NetBackup Restore (True Image) window to show the
folders that are available for true image restores. Notice that the lists show only
folders. Individual files do not appear because true image restores are intended only
for restoring entire folders. To list or select individual files, use Normal Backups.

If NetBackup cannot find any folders, check the Search Folder setting in the Search
Backups dialog box. Also check the range of backups that you are searching
(NetBackup History pane). If all of these settings are correct and no folders are found,
ask the administrator to see if the NetBackup class that is backing up your files and
folders is configured to collect true image restore information.

3. Select the folder you want to restore by marking it in the <variable>Contents of
'<folder>" pane of the NetBackup Restore (True Image) window (you must select from
this side of the window).
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Note When afile in the folder has the same filename as a file in the true image backup,
NetBackup will delete the file from the folder and replace, or restore, the file from
the true image backup. NetBackup will not delete files from the folder that are not
in the true image restore.

4. Click Start Restore of Marked Files on the Restore menu.

By default, NetBackup restores the folder to its original location.

Restoring Files to an Alternate Path

In some instances, you may want to restore items to a file or path other than the one from
which they were backed up. This is called an alternate path restore.

Restoring Everything to a Different Location
1. Open the NetBackup Restore window.
2. Select the items to restore.

3. Click Start Restore of Marked Files on the Restore menu. The Restore Marked Files
dialog box will appear.

4. Click Restore everything to a different location.

5. Inthe Source box, enter the folder from which the items were backed up.

By default, the lowest level folder common to all the items being restored appears in the
Source box. If this is changed to a folder that only contains some of the items, only those

items will be restored to the folder specified in the Destination box. All other items will be
restored to their original location.

6. Inthe Destination box, enter the alternate folder to which you want to restore the
items.
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7. Under Restore Options, select the desired option.

8.

Restoring to Individual Iltems Different Locations
1.

2.

Restore Marked Files B

r~ Restare Destination Chaoice
' Restore evenything to its original location

& Restore evenything to a different location [maintaining existing structure):
Source:
IE:\VEHITAS\NetBackup\

Destination:
IE:\temp Browse... |
' Restore individual folders and files to different locations [double-click to madify):
Source | [ estination I Time Backed Up | Tirmm
CAWERITASWMetB ackupireadme. tat 8/16/995:41: 20 P 8727
<] | i
r Restore Option:

I the destination file already exists:

g a temporary filename

7 Do not restore the file

Start Restore I Cancel Help

Click Start Restore.

NetBackup will restore the items to the new destination folder.

Open the NetBackup Restore window.

Select the files or folders you wish to restore.

Click Start Restore of Marked Files on the Restore menu. The Restore Marked Files

dialog box will appear.

Click Restore individual folders and files to different locations.

To change the destination location for a file:

a. Double click on the file. The Enter New Destination dialog box opens.

b. Type a new path to restore to.

or

Click the Browse button to browse for and select a new path to restore to.
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Restore Using a Temporary Filename

c. Press OK. The new path entered appears in the Destination column.

Restore Marked Files B

r~ Restare Destination Chaoice

' Restore evenything to its original location

Source:

 Restore evenything to a different location [maintaining existing structure):

Destination:

& Restore individual folders and files to different locations [double-click to madify):

Browse... |

Source | [ estination

| Time Backed Up

| Tir

E:\temphzamplefile tat E:\temp3hsamplefile. tat

plefile? tat  E:\temp3hzamplefile?. bt
E:te ;

87/93121230 P 8417
8/17/9312:1230 PM - 8/17

T

<] | i
r Restore Option:
I the destination file already exists:
@& Ovenwite the existing file
' Restore the file using a temporary filename
7 Do not restore the file
Start Restore I Cancel | Help |

d. Repeat these steps for each file, or folder you want to restore

6. Under Restore Options, select the desired option.

7. Click Start Restore.

1. Open the NetBackup Restore window.

2. Select the item to restore.

3. Click Start Restore of Marked Files on the Restore menu. The Restore Marked Files

dialog box will appear.
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4. Select Restore the file using a temporary filename.

Restore Marked Files B

r~ Restare Destination Chaoice

& Restore evenything to its original location

 Restore evenything to a different location [maintaining existing structure):

Source:

Destination:
I Browse... |

' Restore individual folders and files to different locations [double-click to madify):

Source | [ estination I Time Backed Up | Tirmm

CAWERITASWMetB ackupireadme. tat 8/16/995:41: 20 P 8727

<« | i
r Restore Option:

I the destination file already exists:
0 Ovenwite the existing file
& Festore the file uzing a temporary filename

Start Restore I Cancel Help

5. Click Start Restore.

7 Do not restore the file

NetBackup will restore the item to f i | enaneXXXXXX. TMP. Where filename is the
name of the file being restore and XXXXXX is generated based on the current date and
time.

Proxy Restore

In some environments users store their files on a file server rather than on their PC. A
proxy restore allows backups of the file server to be restored to the file server from the
user’s desktop PC.

Note Though you are able to view and mark any of the folders and files in a selected
backup, you will not be able to restore any items you do not have write access to.
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1. Open the NetBackup Restore window.

a. On the Actions menu, point to Select Files and Folders to Restore, then select
from Backup as a Proxy. A Browse for Computer dialog box will appear.

Browse for Computer [ 7] x|

Select Proxy Server

B Alpsum

B Arnold

B Avocado

B Banana

S Barley

B B asil

S Bat

B Bear
Buck

A Runzh LI

ak. | Cancel |

b. Select the file server to which you want to restore folders and/or files and click
OK. For this tutorial we will select a computer called hawk.
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A NetBackup Restore window will appear.

The NetBackup server will change to the master server of the selected file server.

g_ Backup, Archive. and Restore - NetBackup - [Proxy Restore: Server: windows Client: hawk ]

E File Actions Edit Yiew RBestore Window Help - |ﬁ'|1|
_@Select for Backup Select forRestore = | U8y View Status | @
MetBackup History
1999 -
BSeirch Mar Feb
ackups 8 765 4 3 2 1 28 27 26 25 24 232221 20 19 18 17 16
& =] e & o & & & ¢ © e e G_ILI
4 »
Restare I I
All Folders Contents of "hawk’
N ERWPCY hawi Name | Time Backed Up | Atvibutes | Size [ Time Modified |
ol #]=C O=c 3/8/99 8:50:05 PM d--r 0
Unmark.
All +[]= D O=p 3/8/99 8:50:05 PM d--r 0
== E O=€t 3/8/99 8:50:05 PM d--r 0
+[= 6 O=c& 3/4/99 7:30:05 PM d--- 0 3/4/99 7:55:02 PM
Preview
List
Feady él

2. Selectreadne. t xt from the NetBackup folder.

ndows Client: hawk]

nd Restore [MetBackup] - [Proxy Restore: Server:

g Actions Edit ¥Yiew RBestore Window Help
_@Select for Backup Select for Restaore ~ | 3y View Status | @
MetBackup History
1999 il
Search Mar Feb
Backups 8 765 4 3 2 1 28 27 2% 25 24 23 22 21 2019 18 17 16
e & ¢ ¢ ¢ ¢ ¢ © ¢ ¢ e & o .
2 | o
Restore
Contents of "'C:A¥ERITAS\NetBackup'
o Name | Time Backed Up | Atvibutes | Size [ Time Modified |
U;'a;k O3 bin 3/5/99 10:20:00 PM d— 0 2/25/99 3:03:54 PM
All +-[](] AdobePS O logs 374799 7:30:05 PM d-- 0 2/25/99 3:03:54 PM
+-0 download E’?leadme.lxl 3/5/99 10:20:00 PM 6321 8/13/98 5:25:48 PM
+-[](C1 ENGLISH
Presview (1 MOMITOR
List (3 My Documents
N +-[] 1 Perd
b +-[]C1 Program Files
Birief 1 Public
Miew +-[] (] RECYCLED
+-[] (1 TEMP
= +- [ users
Vi --[7](2] VERITAS
(0 Help
a +-[#]E= NetBackup
+-[] ] WINDOWS
gt;gm;ﬂ +-[] L1 WINNT
- []= D
# = E
showtost]| - 6
C 4
3. On the Restore menu, click Start Restore of Marked Files.
N4
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The Restore Marked Files dialog box will open.
4. Select Overwrite the existing file.

5. Click Start Restore.
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3

This chapter provides reference information on the NetBackup Browser. It includes a
description of the Browser menus, windows and dialog boxes.

NetBackup Icons

Menus

The following table describes NetBackup icons you may see on the Microsoft Windows

desktop.

Icon

=

§

[0

N

;

Description

Represents NetBackup. It is used on the title bar in the Browser, in the program
start menu, and Windows Explorer.

Indicates that the NetBackup Client Job Tracker is running, but there are
currently no backups or restores processing. Used in the system tray.

Indicates that the NetBackup Client Job Tracker is running, with at least one
restore processing. Used in the system tray. When the yellow arrow is blinking,
you can open the NetBackup Client Job Tracker for an estimate of the restore
operation.

Indicates that the NetBackup Client Job Tracker is running, with at least one
backup processing. Used in the system tray. When the yellow arrow is blinking,
you can open the NetBackup Client Job Tracker for an estimate of the backup
operation.

Indicates that the NetBackup Client Job Tracker is running, with at least one
backup and one restore processing. Used in the system tray with the yellow
arrows blinking.

This section explains the menu bar commands on the NetBackup Browser.
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File Menu

ckup. Archive, and Restore - NetBackup - Restore:... [Ij[=] E3
Actions Edit ¥Yiew RBestore Window Help
Close Cul+F4

Exit

The commands on the File menu allow you to close Backup and Restore windows and exit

NetBackup.

Close

Exit

Actions Menu

This command appears in the File menu when a NetBackup Backup
window or a NetBackup Restore window is open. Use this command
to close a selected window.

Terminates the browser. Any backups or restores in progress will
continue to completion.

\_._5 Backup. Archive. and Restore - NetBackup - Backup: Server: windows Client: pansy [_ (O] x|

File XSy Edit View Backup Window Help
@ Select Files and Folders to Backup...

Select Files and Folders to Bestore...  » F3, from Backup...

Configure...

Specify HetBackup Machines...

from Archived Backup...
from Raw Partition Backup...
from True Image Backup...

@ Yiew Status...

Select MetWare Server...

from Backup as a Proxy...
from Archived Backup as a Proxy...

Stop

from Raw Partition Backup as a Proxy...
from True Image Backup as a Proxy...

The commands on the Actions menu provide overall control of your NetBackup session.

Select Files and

Opens the NetBackup Backup window. From this window, you can

Folders to Backup select files, folders, or registry keys to back up and then start a backup

Select Files and
Folders to
Restore

from Backup

from Archived
Backup

or archive operation.
Opens the submenu and provides access to the following commands.

Opens a NetBackup Restore window. From this window, you can
select files, folders, or registry keys saved during previous backups
and start a restore operation.

Opens a NetBackup Restore (Archive) window. From this window,
you can select files, folders, or registry keys saved during previous
archives and start a restore operation.
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from Raw
Partition
Backup

from True
Image Backup

from Backup
as Proxy

from Archived
Backup as a
Proxy

from Raw
Partition
Backup as a
Proxy

from True
Image Backup
as a Proxy

Configure

Specify
NetBackup
Machines

View Status

NetBackup
Explorer
Extensions

Stop

Opens a NetBackup Restore (Raw Partition) window. From this
window, you can select raw partitions saved during previous raw
partition backups and start a raw partition restore operation.

Opens a NetBackup Restore (True Image) window. From this window,
you can select files, folders, or registry keys saved during previous
true image backups and start a true image restore operation.

This feature allows a user on a Windows NT/2000 machine to browse
the backups of another Windows NT/2000 machine. The remote user
can select files, folders, or registry keys from the backup and restore to
the remote machine. NetBackup will see all the requests as if they
were coming from the remote Windows NT/2000 machine.

This feature allows a user on a Windows NT/2000 machine to browse
the archive backup of another Windows NT/2000 machine. The
remote user can select files, folders, or registry keys from the backup
and restore to the remote machine. NetBackup will see all the requests
as if they were coming from the remote machine.

This feature allows a user on a Windows NT/2000 machine to browse
the Raw Partition backup of another Windows NT/2000 machine. The
remote user can select files, folders, or registry keys from the backup
and restore to the remote machine. NetBackup will see all the requests
as if they were coming from the remote machine.

This feature allows a user on a Windows NT/2000 machine to browse
the True Image backup of another Windows NT/2000 machine. The
remote user can select files, folders, or registry keys from the backup
and restore to the local machine. NetBackup will see all the requests as
if they were coming from the remote machine.

Opens the NetBackup Configuration dialog box. From this dialog box,
you can specify the parameters that control backups, archives and
restores for your client.

Opens the Specify NetBackup Machines dialog box to the Servers
property sheet. From this dialog you can change the settings for the
master server and client machines.

Opens the View Status dialog box. From this dialog box, you can
review the progress report of a user operation in progress. You can
also review logs from past user directed NetBackup operations.

If the NetBackup Explorer Extensions feature is installed, this item
toggles this feature off and on.

Stops network activities, such as browsing files, folders, or registry
keys for restores. This has no affect on a backup or restore that is
already in progress.
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Edit Menu

\_._3 Backup. Archive, and Restore - NetBackup - Backup: Server: windows Client: pansy !Elm
File Actions m Yiew Backup Window Help
Mark Displayed Files

Unmark Displayed Files
‘£ Unmark All
Preview List of Marked Files...

The commands on the Edit menu modify your selections in the currently selected backup
or restore window. It appears when the NetBackup Backup window or the NetBackup
Restore window are opened.

Mark Displayed  Marks only the files, folders, or registry keys that currently appear in

Files the Contents of '<folder>’ pane of the NetBackup Backup window or
NetBackup Restore window.
Unmark Unmarks only the selections that currently appear in the Contents of

Displayed Files  ’<folder>’ pane of the NetBackup Backup window or NetBackup
Restore window.

Unmark All Unmarks all files, folders, or registry keys in this window. You can
also execute this command by clicking Unmark All on the NetBackup
Restore window toolbar or the NetBackup Backup window toolbar.

Preview List of ~ Opens the Preview List dialog box. This command is enabled when

Marked Files files, folders, or registry keys have been selected in the NetBackup
Backup window or the NetBackup Restore window. You can also
execute this command by clicking Preview List of Marked Files on the
NetBackup Restore window toolbar or the NetBackup Backup
window toolbar.

View Menu

4% Backup. Archive. and Restore - NetBackup

File Actions Help
'ﬁ Status Bar
E Description Bars

@@@ Toolbar Options....

|7 Save Settings on Exit

The commands on the View menu control the contents of the NetBackup Backup window
and the NetBackup Restore window.

- 38 NetBackup User’s Guide - Microsoft Windows



Menus

During a backup or archive operation, the following menu will appear.

ackup. Archive, and Restore - NetBackup - Backup: Server: win._.. !Elm

File Actions Edit Backup Window Help

'ﬁ Status Bar
E Description Bars

@@@ Toolbar Options....

[¥ Usze Checkboxes to Mark Items

Brief

= Full Descriptions of Files

Descriptions of Files

Split

|7 Save Settings on Exit

During a restore operation the following menu will appear.

ackup. Archive, and Restore - NetBackup - Restore: Server: win.__ !Elm

Actions  Edit Bestore Window Help

'ﬁ Status Bar
E Description Bars

@@@ Toolbar Options....

[¥ Usze Checkboxes to Mark Items

|7 Show MetBackup History as a Timeline

Brief

Full Descriptions of Files

Descriptions of Files

’,'h Show All Backups
'ﬁ Show Most Recent Backup

Split

MetBackup History Split
Refresh NetBackup History

|7 Save Settings on Exit

Status Bar
Description Bars

Toolbar Options

Use Checkboxes to
Mark Items

Show NetBackup

Shows the NetBackup status bar.

Shows the description bars on the backup and restore window
panes. Clear this check box to turn off the description bars.

Opens the Toolbar Options dialog box. Go to “Toolbar Options
Dialog Box” on page 68 for more details.

When selected, checkboxes will be shown that are used to mark
items for backup or restoring. When not selected, circles will be
shown.

Displays the NetBackup History pane as a timeline. To show the

History as a NetBackup History pane as a detailed list, clear this checkbox.
Timeline
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Brief Description of Shows files, folders, or registry keys without details. You can also

Files

Full Description of
Files

Show All Backups

execute this command on the NetBackup Backup window toolbar
and on the NetBackup Restore window toolbar.

Shows file, folder or registry key details such as size and file
permissions. You can also execute this command on the NetBackup
Backup window toolbar and on the NetBackup Restore window
toolbar.

Shows all instances of files, folders, or registry keys in the currently
selected image(s). You can also execute this command on the
NetBackup Restore window toolbar.

Show Most Recent Shows the most recent backup of files, folders, or registry keys from

Backup

Split

NetBackup History
Split

the currently selected backup image(s). You can also execute this
command on the NetBackup Restore window toolbar.

Changes the cursor to a double bar with two arrows and positions it
over the vertical split bar between the All Folders and Contents of
'<folder>’ panes. You can then move the cursor left or right to
position the split bar.

Changes the cursor to a double bar with two arrows and positions it
over the horizontal split bar between the NetBackup History pane
and the All Folders and Contents of '<folder>’ panes. You can then
move the cursor up or down to position the split bar.

Refresh NetBackup Updates information in the NetBackup History pane.

History

Save Settings on
Exit

Backup Menu

When selected, this command will save window specific settings
upon exit.

ackup. Archive, and Restore - NetBackup - Backup: Server: win._.. !Elm

File Actions Edit Yiew

Window Help

Specify Class and Schedule

% Start Backup of Marked Files. ..

Add to Exclude List
Add to Include List

The Backup menu appears when the NetBackup Backup window is active. The
commands on the Backup menu control backup operations.

Specify Class and
Schedule

Opens the Backup Class and Schedule dialog box. Go to “Backup
Class and Schedule Dialog Box™ on page 69 for more details.
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Start Backup of
Marked Files

Add to Exclude
List

Add to Include
List

Restore Menu

ﬁ Backup, Archive, and Restore - NetBackup - Restore: Server: windows Client: pansy
File Actions Edit View Window Help
ﬂ Search Backups...

Opens the Specify Backup Options dialog box. You can also execute
this command by clicking Start Backup on the NetBackup Backup
window toolbar.

Adds the selected files, folders, or registry keys to the Exclude File
List. For more details, refer to “Exclude List Property Sheet” on

page 95.

Adds the selected files, folders, or registry keys to the Include File List.
For more details, refer to “Include List Property Sheet” on page 96.

@ Start Restore of Marked Files...

Select Restore Type... 4 |7 Hommal Backups

Auchived Backups
Raw Partition Backups

Tiue Image Backups

Proxy Nommal Backups

Proxy Auchived Backups

Proxzy Raw Patition Backups

Proxy Twue Image Backups

The Restore menu appears when the NetBackup Restore window is active. The
commands on the Restore menu control restore operations.

Search Backups

Start Restore of
Marked Files

Select Restore
Type
Normal
Backups

Archived
Backups

Raw Partition
Backups

Opens the Search Backups dialog box. You can also execute this
command by clicking Search Backups on the NetBackup Restore
window toolbar.

Opens the Restore Marked Files dialog box. You can also execute this
command by clicking Start Restore on the NetBackup Restore
window toolbar.

Opens the submenu and provides access to the following commands.

Opens the NetBackup Restore window. You can select files, folders, or
registry keys saved during previous backups and start a restore
operation.

Opens the NetBackup Restore (Archive) window. You can select files,
folders, or registry keys saved during previous archives and start a
restore operation.

Opens the NetBackup Restore (Raw Partition) window. You can select
and start a raw partition restore operation.
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True Image Opens the NetBackup Restore (True Image) window. You can select
Backups files, folders, or registry keys and start a true image restore operation.

Proxy Normal This feature allows a user on a Windows NT/2000 machine to browse

Backups the backups of another Windows NT/2000 machine. The remote user
can select files, folders, or registry keys from the backup and restore to
the remote machine. NetBackup will see all the requests as if they
were coming from the remote Windows NT/2000 machine.

Proxy Archived This feature allows a user on a Windows NT/2000 machine to browse

Backups the archives of another Windows NT/2000 machine. The remote user
can select files, folders, or registry keys from the backup and restore to
the remote machine. NetBackup will see all the requests as if they
were coming from the remote Windows NT/2000 machine.

Proxy Raw This feature allows a user on a Windows NT/2000 machine to browse
Partition the raw partition backups of another Windows NT/2000 machine. The
Backups remote user can select files, folders, or registry keys from the backup

and restore to the remote machine. NetBackup will see all the requests
as if they were coming from the remote Windows NT/2000 machine.

Proxy True This feature allows a user on a Windows NT/2000 machine to browse
Image the true image backups of another Windows NT/2000 machine. The
Backups remote user can select files, folders, or registry keys from the backup

and restore to the remote machine. NetBackup will see all the requests
as if they were coming from the remote Windows NT/2000 machine.

Window Menu

__3 Backup. Archive, and Restore - NetBackup - Restore: Server: windows Client: pansy
File Actions Edit Yiew Hestore Help
LCascade Shift+F5
Tile Horizontally Shift+F4
Tile Yertically
Amrange lcons

Close All

1 Backup: Server: windows Client: pansy
v 2 Restore: Server: windows Client: pansy

The Window menu has commands for arranging your NetBackup windows. It appears
when the NetBackup Backup window or the NetBackup Restore window is opened.

Cascade Arranges NetBackup windows so they overlap, but the title bars will
still be visible.

Tile Horizontally — Modifies the size of NetBackup windows and arranges them
horizontally on the desktop.
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Tile Vertically Modifies the size of NetBackup windows and arranges them vertically
on the desktop.
Arrange Icons Arranges icons so they are located in the lower left corner of the
desktop.
Close All Closes the NetBackup Backup windows and the NetBackup Restore
windows.
Help Menu

\_._5 Backup. Archive, and Restore - NetBackup

File Action: Yiew m

7 Select for Backup & Contents 2 View Status | &

Search for Help On...
How to Use Help

0 YERITAS Web Page

@ About NetBackup...

This menu provides access to the online instructions for using NetBackup.

Contents Opens the table of contents in the online help.
Search For Help  Opens the search facility for the online help.
On

How to Use Help Describes how to use the online help.
VERITAS Web Opens the VERITAS Web site in your internet browser.

Page

Copyrights Displays additional copyright information for NetBackup.
About Displays information about NetBackup, including the version
NetBackup number.
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Windows

This section explains the windows on the NetBackup Browser.

NetBackup Window Icons

This section describes all icons displayed in the windows.

I 8
- =]

n

o H @ 0l

B 0O N

Description

Represents NetBackup. It is used on the title bar in the Browser, in the program
start menu, and Windows Explorer.

Represents a backup. It is used on the title bar of the backup window.
Represents a restore. It is used on the title bar of the restore window.

Represents a floppy drive. Used in the All Folders pane.

Represents a logical hard drive. Used in the All Folders pane.

Represents a CD-ROM drive. Used in the All Folders pane.

Represents a networked drive. Used in the All Folders pane.
Represents a client PC. Used in the All Folders pane.

Expand or collapse these structures to see more or fewer subentries. A plus sign
indicates that the folder can be expanded. A minus sign indicates that the folder
can be collapsed. Used in the All Folders pane.

Represents a closed folder that may or may not contain other items. Used in the
All Folders pane where only folders are displayed under drives. Also in the
Contents of '<folder>’ pane.

Represents an opened folder that may or may not contain other items. Used in the
All Folders pane where only folders are displayed under drives.

Represents a file or a folder, with all of its contents, that has been marked for
backup or restore. Used in the All Folders pane and the Contents of '<folder>’
pane.

Represents a folder with some of its contents marked for backup or restore. Used
in the All Folders pane and the Contents of '<folder>’ pane.

Represents a file or folder that has not been marked for backup or restore, but
could be. Used in the All Folders pane and the Contents of '<folder>’ pane.

Represents an object with all of its contents marked for backup or restore, but the
object itself cannot be marked. Used in the All Folders pane and the contents.
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Icon  Description

Represents an object with some of its contents marked for backup or restore, but
the object itself cannot be marked. Used in the All Folders pane and the contents
and Contents of '<folder>’.

D Represents an object that cannot be marked for backup or restore but contains
other objects that can be marked for backup or restore. Used in the All Folders
pane and the contents and Contents of ’<folder>’.

Represents a folder that wasn’t specifically backed up, but at least some of its
contents were backed up. Used in the All Folders pane of the NetBackup Restore
window.

Represents a file that doesn’t have an icon associated with it. Used in the Contents
of '<folder>’ pane.

Represents the entire registry. Used in the All Folders pane.

The registry opens to two base keys: HKEY_LOCAL_MACHINE and
HKEY_USERS.

Represents a registry key. Used in the All Folders pane. Also used in Contents of
'<folder>’ pane if it contains subkeys.

Represents the entire network. Used in the All Folders pane.

Represents a specific network. Used in the All Folders pane and the Contents of
'<folder>’ pane.

Represents a domain within a network. Used in the All Folders pane and the
Contents of "<folder>’ pane.

B @ & & I
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Backup, Archive, and Restore - NetBackup Window

ackup. Archive, and Restore - NetBackup

File Actions Yiew Help

B Select for Backup | EFSelect for Restore + | By Wiew Status

Feady él
This window appears when you start NetBackup. The following buttons appear on the
toolbar.
Button Description
@ Opens the NetBackup Backup window.

Opens the NetBackup Restore window.
Opens the View Status dialog box.

Updates the list of backup images. This button
¥ is only available when a Restore window is
open has the focus.

@ Opens the online help.
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NetBackup Backup Window

B Select for Backup | B Select for Restore -

) View Status | @

All Folders Contents of C:\
028 A Hame | Attributes | Size | Tim(~
= =008 C]C1AdobePS d— 0 42
Bachyp |E-CJ=D 1 download d--- 0 172,
+O0=E O CIENGLISH d--- 0 12
o O&F O CIMOMITOR d--- 0 12
Unrnark 096 1 My Documents d--- 0 172
A |mOSH OCaPen d-- 0 51
. Eg : 013 Program Files der 0 1721
Pevie | C]F Network (3 Public d--- 0 22
Lk - D@ Registry 1 Real d--- 0 41,
- O CIRECYCLED dsh- 0 121
o OCITEMP d--- 0 22
5.'.;?,{, O (users d- 0 5/21
COCIVERITAS d--- 0 421
OCIVRTSwland d--- 0 9/,
Ful O WINDDWS d--- 0 1720~
Wigw | | v
Feady él

This window shows the files, folders, or registry keys you can mark for back up. To access
this window:

0O From the Actions menu, choose Select Files and Folders to Backup

0O From the toolbar, choose Select for Backup

You can position this window separately. You can also cascade, tile or minimize the
window by using commands from the Window menu.

Buttons

Button

=

[
[

Description

Opens the Specify Backup Options dialog box. From this dialog you can start

the backup operation.

Unmarks all files, folders and registry keys in this window. You can also execute
this command by selecting Unmark All from the Edit menu.

Opens the Preview List dialog box during a backup operation. You can also

execute this command by selecting Preview List from the Edit menu.

Shows files and folders only. You can also execute this command by selecting
Brief Descriptions of Files from the View menu.
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Button  Description

Showvs file, folder and registry key details such as size and file permissions. You
can also execute this command by selecting Full Descriptions of Files from the
View menu.

Panes

The NetBackup Backup window contains two panes: All Folders and Contents of
‘<folder>".

O To adjust the width of the panes, position the cursor over the split bar. The cursor will
change to a double-headed arrow. Press the left mouse button and move the cursor
left or right to position the split bar.

O Toresize columns in a pane, move the mouse over the column header until the cursor
changes to a double-headed arrow. Hold the left mouse button down and move the
mouse left or right to decrease or increase the column width.

0O To sort information in a pane, click on the column header for the information you
wish to sort by. For example, to sort the pane by “Size,” click on the Size column. This
will sort the list from the smallest to largest size. Click the Size column again to sort
from largest to smallest.
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NetBackup Restore Window

!_5 Backup, Archive, and Restore - NetBackup - [Restore: Server: windows Souice Client: pansy Destina... !En
E File Actions Edit View Hestore Window Help _|5|5|

‘iew Status | &

23 Select for Backup | EFSelect for Restore -

HetBackup History

1999
h Sep Aug
Backups 9 8 7 6 5 4 3 2 1 3} 3\ 29 MW 27 % ¥/ A
| e & 8 E & E B e E E & & & &
3 @
Start ~
Restore
ofy
o[f
Unmark,
S K I 2
All Folders Contents of 'pansy’
Pri\_fiztaw = DB pansy Time Backed U Attributes | Size | Time Modifie
N +Od=¢C CO=C 9/9/1999 10:28:25 PH d-r 0
w,e + =D =D 9/91199910:28:25 PW d-1 0
Bbr;ef +J=E J=E 9/81199911:0259 PW d-r 0
Yiew +=6 =6 9/91199910:28:25 PH d-r 0

Show A1 <] |
Ready

s =

This window shows the files, folders, or registry keys that you can mark for restore. To
access this window:

O From the Actions menu, click Select Files and Folders to Restore, then choose the
desired type of restore

O To open the same type of restore as opened previously, click Select for Restore on the
toolbar

O To open a different type of restore, click the arrow next to the Select for Restore
button, then select the desired type of restore

The folder trees in this window contain only files and folders that were backed up. You
can position this window separately. You can also cascade, tile or minimize the window
by using the command from the Window menu.

Note If the client belongs to more than one class, the default display starts with the last
full backup that occurred first. For example, assume that the client belongs to Class
A and Class B and full backups occur for both of them. If the last full backup for
Class A occurred before the one for Class B, then the display shows files ranging
from the time of the Class A full backup.
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Note If you are restoring from a true image backup, the NetBackup Restore window
shows only the folders that were included in true image backups. Files do not
appear in this window because you cannot select individual files for a true image
restore.

Note If the NetBackup Restore window does not show any files, folders, or registry keys,
check the items below.

If files or folders do not appear in the NetBackup Restore window, it can be due to one
of the following:

0O Perform default search is not enabled. In this case, start a search manually by
clicking Search Backups on the Restore menu. Or to display the files in a backup,
click a backup image.

0O The NetBackup server does not have any backups of files for your client. Ensure
that the client is connecting to the correct server (see “Servers Property Sheet” on
page 61). Also, ensure that you are using the correct client name (see “General
Property Sheet” on page 54). You can also refer to the title bar. If these settings are
correct and you believe there are backups available, contact your system
administrator.

Buttons
Button Description
Opens the Search Backups dialog box.

Opens the Restore Marked Files dialog box. From this dialog you can start the
restore operation.

Unmarks all files, folders, or registry keys in this window. You can also execute
s[5~  this command by selecting Unmark All from the Edit menu.

Opens the Preview List dialog box during a restore operation. You can also
B execute this command by selecting Preview List of Marked Files from the Edit

menu.
b - Shows files and folders only. You can also execute this command by selecting
k- Brief Descriptions of Files from the View menu.

Showvs file, folder or registry key details such as size and file permissions. You
can also execute this command by selecting Full Descriptions of Files from the
View menu.
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Button Description

% Shows all instances of the files, folders, or registry keys in the currently selected
&E image(s). You can also execute this command by selecting Show All Backups
from the View menu.

Shows the most recent backup of files, folders, or registry keys in the selected
QQEE backup images. You can also execute this command by selecting Show Most
Recent Backup from the View menu.

Panes

The NetBackup Restore window is split into three panes: the NetBackup History pane on
the top, the All Folders pane on the left and the Contents of '<folder>’ pane on the right.

0O To adjust the height of the NetBackup History pane, position the cursor over the
horizontal split bar. The cursor will change to a double bar with two arrows. Press the
left mouse button and move the cursor up or down to position the split bar.

0O To adjust the width of the All Folders pane and the Contents of '<folder>’ pane,
position the cursor over the vertical split bar. The cursor will change to a double bar
with two arrows. Press the left mouse button and move the cursor left or right to
position the split bar.

0O To resize columns in a pane, move the mouse over the column header until the cursor
changes to a double-headed arrow. Hold the left mouse button down and move the
mouse left or right to decrease or increase the column width.

0O To sort information in a pane, click on the column header for the information you
wish to sort by. For example, to sort the pane by “Size,” click on the Size column. This
will sort the list from the smallest to largest size. Click the Size column again to sort
from largest to smallest.

NetBackup History Pane

The NetBackup History pane shows the NetBackup image(s). When first opened, the
following backup images are selected by default:

0O The most recent full backup.

0O All cumulative-incremental backups and differential-incremental backups since the
most recent full backup.

O All user directed backups that have occurred since the most recent full backup.

If there is no full backup, only the most recent image will be selected.
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To Open the NetBackup History Pane

O Position the cursor over the horizontal split bar. The cursor will change to a
double-headed arrow. Press the left mouse button and move the cursor up or down to
position the split bar.

or

O On the View menu, click NetBackup History Split. This changes the cursor to a
double-headed arrow. Move the cursor up or down to position the split bar. Click the
left mouse button to hold position.

Backup History as a Timeline

MetBackup History
1939
Mar Feb
3 1 10

201 28 27 26 2 XM 2302 021 20 19 18 17 16 15 14 13 1 9

[—][—][—][—][—][—][—]5’] 4]
€3 L]
=

<« | v

To show the NetBackup History pane as a timeline, from the View menu click Show
NetBackup History as a Timeline.

The icons, representing images, appear directly underneath the date of the backups. Icons
with a square represent selected backup images. Several backup image icons may appear
below a date. The most current backup image is on top of the list. As you move the cursor
over the icons, tool tips will show the schedule type and the date and time of the backup.

Tip If you do not see tool tips, open the Toolbar Options dialog box from the View menu
and select Show tool tips.

Icon Description

This green icon represents a full backup.
This blue icon represents a differential incremental backup.

This light blue icon represents a cumulative incremental backup.
This red icon represents a user directed backup.

This yellow icon represents a user directed archive.

DEOQIOC

This grey icon represents an unknown type of backup.
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v To Select Backup Images
O Select a single backup image by clicking on it
O Select a range of backup images by clicking on the first, holding down the Shift key,
and clicking on the last image.

v Backup History as a Detailed List

MetBackup History |
Time Backed Up Time Expiresl FiIesI Size| Compreszed | Schedule Type | Clazs Mame | Ke
3/3/99 35912 PM 4/5/99 173 17240 M Diff Incr Backup  production_pos NT_30 «
3/2/99 84307 PM 444493 194 18416 M Diff Incr Backup  production_pcs MT_3-0
341499 8:29:45 PM 443499 417 93053 M Diff Incr Backup  production_pcs MT_3-0
2/28/9910:15:59 PM 442499 122 28944 M Diff Incr Backup  production_pes NT_3-00

To show the NetBackup History pane as a detailed list, clear the Show NetBackup History
as a Timeline checkbox on the View menu. The list starts with the most recent backup and
includes the following information (reading from left to right).

0O Date and time when the backup occurred.

0O Date when NetBackup will expire the backup and delete it from the NetBackup
History pane.

Number of files in the backup.

Size of the backup in kilobytes.

Whether the backup is compressed (Y for yes, N for no).
Type of schedule.

O 0o o o o

Name of the class associated with the backup. The system administrator configures
the class hames, as explained in the NetBackup System Administrator’s Guide - UNIX or
the NetBackup System Administrator’s Guide - Windows NT/2000.

0O Keyword assigned to the backup.
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Dialog Boxes

This section describes the dialog boxes on the NetBackup Browser.

NetBackup Configuration Dialog Box

This section explains the property sheets found in the NetBackup Configuration dialog
box.

General Property Sheet

NetBackup Configuration m
Metwork, | Wirus Protection | TroubleShoating |
General | Exclude List | Include List | Backups
Client name:
|M

Lizt files timeout:
|3DD _I:j seconds ID _I:j
Time overlap:
IBD _I:j mirutes IBD =1

Keep statuz of uger-directed backups,
archives, and restores for:

|3 _I:j daps
V¥ Perform incrementals bazed on archive bit
¥ Allow server-directed restores

W Perform default search

Restore refries:

User-directed operation timeout:

= seconds

’TI Help |

Cancel |

To access this property sheet:

1.

2.

From the Actions menu, select Configure.

Click the General tab.

Use this property sheet to set any of the configuration parameters for your client. Only the
system administrator should change the following parameters.

O 0o o o o oo

Client name

List files timeout

Restore retries

Time overlap

User-directed operation timeout:

Perform incrementals based on archive bit
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O Allow server-directed restores

System administrators should refer to “General Property Sheet” on page 92 for details on
these parameters.

The NetBackup client user as well as the system administrator can change following

parameters.

Keep status of Specify the number of days to store progress reports before the system
user-directed will automatically delete them. Default is 3 days. The minimum
backups, allowable value is zero. The maximum is 9,999.

archives, and
restores for:

Perform default  If selected, NetBackup will automatically search the default range of
search backup images and display the backed up folders and files whenever
a restore window is opened.

Clear this box to disable the initial search. The NetBackup Restore
window will not show any files or folders when initially opened.
Clicking a backup image, or selecting a range of backup images, will
initiate a search.

By default, this box is selected.
OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Exclude List Property Sheet

Only the system administrator should change the parameters on this property sheet.
System administrators should refer to “Exclude List Property Sheet” on page 95 for details
on these parameters.

Include List Property Sheet

Only the system administrator should change the parameters on this property sheet.
System administrators should refer to “Include List Property Sheet” on page 96 for details
on these parameters.
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Backups Property Sheet

MetBackup Configuration m

Metwork, | Wirus Protection | TroubleShoating |
General | Exclude List | Include List Backups

Backup Class:

P

Backup Scheduls:
Iany

Archive Class:
Iany

Archive Schedule:
Iany

QK I Cancel | Help |

To access this property sheet:

1. From the Actions menu, select Configure.

2. Click the Backups tab.

Use this property sheet to specify specific class and schedules to use when you start a
backup from the client.

Note Changes made to the this property sheet will not apply to currently open backup
window. The changes will apply to all backup windows opened after the property
sheet modifications have been saved.

Backup Class Specify the class to use for user-directed backups of this
client. If you set this value to any (default), NetBackup uses
the first class that it finds with both the client name and a
user-directed backup schedule.

Backup Schedule Specify the schedule to use for the user-directed backups for
this client. If you set this value to any (default), NetBackup
uses the first user-directed backup schedule in the first class
that it finds with both the client name and a user-directed
backup schedule.
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Archive Class

Archive Schedule

OK
Cancel

Help

Specify the class to use for user-directed archives of this client.
If you set this value to any (default), NetBackup uses the first
class that it finds with both the client name and a
user-directed archive schedule.

Specify the user-directed archive schedule to use for
user-directed archives of this client. If you set this value to
any (default), NetBackup uses the first user-directed archive
schedule in the first class that it finds with both the client
name and a user-directed archive schedule.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without
accepting changes to the parameters in this dialog box, click
this button.

To view online help for this dialog box, click this button.

Network Property Sheet

Only the system administrator should change the parameters on this property sheet.
System administrators should refer to “Network Property Sheet” on page 98 for details on
these parameters.

Virus Protection Property Sheet

MetBackup Configuration m

| Exclude List | Include List | Backups |
Wirus Protection | TroubleShooting

General
Metwork,

™ Perform virus scanning for backup

[ Clean infected files
[ Backup infected files

[ Perform wvius scarning for restore

[ Clean infected files

o]

Cancel | Help |

To access this property sheet:
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1. From the Actions menu, select Configure.

2. Click the Virus Protection tab to open the property sheet.

Use this property sheet to configure the NetBackup client to pre-scan data before it is
backed up. By default, virus scanning is turned off.

Note The changes and options in this dialog box do not apply to any open windows. The
values are set on a machine basis. If an option’s value is changed, the next backup or
restore operation will see the changed value, no matter where the operation was

initiated.

Perform Virus
Scanning for
Backup

Clean Infected
Files

Backup
Infected Files

Perform Virus
Scanning for
Restore

Clean Infected
Files

OK
Cancel

Help

Activity Logs

Select this option to perform virus scanning and detect any infected
files. NetBackup does not attempt to correct or backup the infected
files. The activity log is updated with the total number of scanned
files, and infected files.

Select this option to correct the infected files. If a file cannot be
cleaned, it is skipped and will not be backed up. The activity log is
updated with the infected file name and its associated virus name.

Select this option to include infected files in the backup. However,
backing up infected files is not recommended. The data still contains
the virus when restored to another system. The activity log is updated
with the infected file name and its associated virus name.

Select this option to perform virus scanning and detect any infected
files. NetBackup does not attempt to correct or restore the infected
files. The activity log is updated with the total number of scanned
files, and infected files.

Select this option to correct the infected files. If a file cannot be
cleaned, it is skipped and will not be restored. The activity log is
updated with the infected file name and its associated virus name.

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

NetBackup records the results in the activity logs on the client. To enable activity logging
for virus scanning, create either the bpbkar or bpcd log directory on the client:

install_path\ Net Backup\ | ogs\ bpbkar\ (on Windows NT/2000)
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install_path\ Net Backup\ | ogs\ bpcd\ (on Windows 95 and 98)
Logs are then written in the activity log directory in the form:
yymmdd. | og

Messages about infected files are also sent to the server so they appear in the reports.

Limitations

O Files with the following conditions are not scanned for viruses:
O Fully qualified file names longer than 255 characters
0O Open files that are locked

0O Avirus found in a compressed file cannot be cleaned, although the virus will be
detected and reported in the activity log.

Notes About Virus Scanning

Before using NetBackup virus scanning, disable any virus protection software that is
already installed on the system. Other anti-virus software can slow down NetBackup’s
virus scanning process. It can also cause unnecessary alerts or unexpected warning
messages.

New viruses constantly appear, so it is important to keep the protection signature (. DAT)
files up to date. VERITAS recommends that you manually download these files from our
ftp site every 30 days. The download procedure is as follows (Internet access is required).

Recommended ftp site

1. Download the most recent . ZI P file from the VERITAS support ftp site:
ftp://ftp.support.veritas.com pub/support/Products/ nai/NetBackup/

Note Currently / nai is a hidden directory.

2. Unzip the. ZI P file to get CLEAN. DAT, NAMES. DAT, and SCAN. DAT files
3. Copy the . DAT files to the install_path\ Net Backup\ bi n folder.

4. Delete the downloaded . ZI Pfile, if you wish.
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Optional ftp site

1. Download the most recent standard . ZI P file from the McAfee ftp site:
ftp://ftp. ncafee. com pub/antivirus/datfiles/4.x/

2. Unzip the. ZI P file to get CLEAN. DAT, NAMES. DAT, and SCAN. DAT files. NetBackup
uses only these files, ignore the rest.

3. Copy CLEAN. DAT, NAMES. DAT, and SCAN. DAT files to the
install_path\Net Backup\ bi n folder.

4. Delete the downloaded . ZI P file and other (unzipped) files, if you wish.

Troubleshooting Property Sheet

Only the system administrator should change the parameters on this property sheet.
System administrators should refer to “Troubleshooting Property Sheet” on page 99 for
details on these parameters.
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Specify NetBackup Machines Dialog Box

This section explains the property sheets found in the Specify NetBackup Machines dialog
box.

Servers Property Sheet

Specify HetBackup Machines m

Servers | Clients I

Mew Server Mame:

Server List:

windowz[CURREMT]
carrat

Bemove |MakeEurrent|

V! Use this server list for future backup and restore windaws

QK I Cancel | Help |

To access this property sheet:

1. On the Actions menu, choose Specify NetBackup Machines.

2. Click on the Servers property sheet.

Use this property sheet to add and remove NetBackup servers and to specify the current
server to be used for user operations.

New Server To add another NetBackup server to the Server List, type the name of
Name the new server in the New Server Name text box and click Add. The
name must be as defined by the system administrator on that server.

If a new server is added to the list from this dialog box, it will appear
in the server list for all windows currently opened and any new
window that is opened. The new server will be saved in the Server
List box after the current window is closed.

Add Adds the server, entered in the New Server Name box, to the Server
List.
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Server List Shows the names of the NetBackup servers that require access to the
client for scheduled backups, and any other servers used when
performing user directed backups. The master server and any remote
media servers that perform scheduled backups of the client must
appear in this list. The machine designated as CURRENT will be the
server used for user directed operations.

To mark a server as CURRENT, select a server from the Server List
and click Make Current. The word CURRENT appears in parentheses
beside the name.

Remove Removes a server. First highlight the server in the Server List, then
click Remove.

Note: The master server cannot be removed from the Server List.
While other servers can be removed from the list, be careful not to
remove any remote media servers. Doing so will prevent scheduled
backups from being performed. For more information on making
changes to the Server List, refer to the NetBackup System
Administrator’s Guide - UNIX or the NetBackup System Administrator’s
Guide - Windows NT/2000.

Make Current First highlight the server in the Server List, then click Make Current.
Changing the current server will affect only the selected window. This
setting will not be saved after the currently selected window is closed.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Clients Property Sheet

If the NetBackup Backup window is active when you open the Clients property sheet, you
will see the following:

Specify HetBackup Machines m

Servers | Clients |

Mew Client Mame:
Add
Cliert List:
Bemove | Make Cumant |
¥ Use this client list fior future backup and restare windows

QK I Cancel | Help |

If the NetBackup Restore window is active when you open the Clients property sheet, you
will see the following:

Specify HetBackup Machines m

Servers | Clients |

Mew Client Mame:

Cliert List:
pansy[CURRENT]

Make Cumant |

V! Use this client list for future backup and restore windows

Clazs Type:
[MS Windaws-NT ~|
QK I Cancel | Help |

To access this property sheet:
1. From the Actions menu, select Specify NetBackup Machines

2. Select the Clients property sheet.

Chapter 3, Reference 63 ~



Dialog Boxes

Use this property sheet to select the remote client whose backups you want to restore to
your client. You can also add names of remote clients.

Note Most changes made to the this property sheet will not apply to currently open
backup or restore windows. If, however, a client is added, the open windows will be
able to switch to them.

New Client Name

Add
Client List

Remove

Make Current

Class Type

Use this client list
for future backup
and restore
windows

To add another client name to the Client List, type the name of the
client in the New Client Name and click Add. The client name entered
must also be defined in a class on the NetBackup server.

If a new client is added to the list it will be in the client list for all
windows currently opened and any new window that is opened. The
new client will be saved in the Client List box after the current window
is closed.

Adds the client, entered in the New Client Name box, to the Client List.

The Client List contains the client name for your computer. It can also
contain the names of remote NetBackup clients. You can select local or
remote NetBackup clients on which to perform NetBackup operations.

The NetBackup server administrator must set up the required
permissions before you can browse and restore from any remote
client.

To perform a NetBackup operation on a NetBackup client, select the
name from the Client List and click Make Current. The word
CURRENT appears in parentheses beside the name of the new default
client.

Removes a client. First highlight the client in the Client List, then click
Remove.

Designates the client backup images you can browse for restore
operations. First highlight the client in the Client List, then click Make
Current. Changing the current client will affect only the selected
window. This setting will not be saved after the currently selected
window is closed.

View and select class type for the client selected in the Client List. The
class type must be the same as specified for the client in the
NetBackup configuration on the NetBackup server.

If selected, NetBackup applies any changes to the client list to all
backup and restore windows opened after the property sheet
modifications have been saved.
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OK
Cancel

Help

To accept changes to the parameters, click this button.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dia

View Status Dialog Box

—m

Backup

- Selected Operation:

2/17/33 11:00:55 AM)
8/16/33 5:38:29 PM

log box, click this button.

&8 View Status [gla) !El m
Operation Type | Time Fequested Operation Status | I Cloze |
Fie:storel (=24 S f

5 sl
Successhul

Help

Delete |
TR

[T Werhose

Progress:

Refresh Rate [seconds): Im ﬂ
il

11:01:16 [61351.001) INF
11:04:26 [61351.001) INF

11:01:15 (61351.001) INF -

TAR STARTED

- aiting for mount of media id BOD30 on server carat,

- W aiting for pogitioning of media id BOO30 on server carrat.
11:05:18 [61351.001) INF -

11:05:26 (61351.001) INF -
11:05:26 (61351.001) INF -
11:05:26 (61351.001) INF -
11:05:26 (61351.001] INF -

Beginning restore from server camot to client pansy.
TAR EXITING WITH STATUS =0

TAR RESTORED 1 0F 1 FILES SUCCESSFULLY
TAR KEPT DEXISTIMG FILES

TAR PARTIALLY RESTORED OFILES

11:05:28 [E1357 xux] IMF - Status = the requested operation was successfully completed,

al »

To access this dialog box:
O From the Actions menu, select View Status.

O From the toolbar on the Backup, Archive, and Restore - NetBackup window, click
View Status.

Use this dialog box to view the results of each user operation in a progress report.

Note If a backup is split across more than one media ID, the Status lists all the media.

NetBackup uses only what it needs to restore the requested files, folders, or registry
keys.
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Operations List  Lists operation status reports for NetBackup operations. The most
current NetBackup operation is on top of the list.

By default NetBackup operation status reports will be stored on the
NetBackup client for three days. Refer to “General Property Sheet” on
page 54 for more information on changing the configuration setting
called Keep status of user-directed backups, archives, and restores

for:.

Operation Shows the type of NetBackup operation for the selected progress

Type report: backup, archive or restore.

Time Shows the start date and time of the selected NetBackup operation.

Requested The format of the start date and time depends upon how the date and
time display has been configured on the computer.

Operation Shows the status of a NetBackup operation.

Status

Close Closes the dialog box. Close does not terminate NetBackup or affect

other dialog boxes or windows.

Delete Deletes the progress report selected in the Operations List. First select
the progress report in the Operations List then click Delete.

Operation status reports are automatically deleted after a specified
number of days. The Keep status of user-directed backups, archives,
and restores for: parameter in the General Property Sheet on the
NetBackup Configuration dialog box specifies the number of days.

Help To view online help for this dialog box, click this button.

Refresh Rate Changes the rate at which NetBackup updates the Status display for
(seconds) the selected operation. Recommended value is 10. This parameter can
be set at any time during a NetBackup operation.

Enter a value (in seconds) in Refresh Rate (seconds).
or

Use the spin buttons to the right of Refresh Rate (seconds). A value of
0 turns off automatic refreshing.

Refresh Updates the Status display for the selected NetBackup operation.
Refresh is enabled when a NetBackup operation is selected from the
Operations List.

Verbose Generates a more detailed progress report for the selected NetBackup
operation.
Print Opens the Microsoft Windows print dialog box and prints out the

progress report for the selected NetBackup operation.
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Progress

Displays the progress of the selected operation. If the Refresh Rate
(seconds) parameter is set to 0, the user can click Refresh to view the
progress of the selected NetBackup operation.

Each message begins with the time of the related event and an
acronym that indicates the nature of the message. Status also lists all
the media IDs used to store the data.

Select Verbose for a more detailed progress report.
Following is a list of acronymes.

Note: If the drive on which NetBackup is installed is full, no progress
messages are displayed except those indicating the job has been
initiated and the job has been completed.

DAT Informational messages that are helpful in debugging.
ERR Error message.

FTL Fatal error message.

I NF Informational message (no error occurred).

TRV Trivial error message.

WRN Warning error message.

Preview List Dialog Box

To access this dialog box:

0O From the NetBackup Backup window, click the Preview List button. The following

will appear.

M ame

Chirty

Help
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O From the NetBackup Restore window, click the Preview List button. The following

will appear.

Mame | Time BackedUp | Time Modiied |

F: 4/8/33 73708 PM 4/8/99 B:22:36 PM

0O From the Edit menu, select Preview List of Marked Files. The Preview List dialog box
which appears depends upon the backup or restore window currently selected.

Use this dialog box to view all of the files, folders, or registry keys you have marked. This
is a view-only dialog box.

Name Lists the file or folder being restored.

Time Backed  Lists the time the backup was initiated.

Up

Time Modified Lists the time that the file or directory, that was backed up, was changed.

Close Closes the dialog box. Close does not terminate NetBackup or affect
other dialog boxes or windows.

Help To view online help for this dialog box, click this button.

Toolbar Options Dialog Box

Toolbar Options B

V! Show toolbar
V! Show tool tips
V! Flat toolbars

I

Large buttons

ok I Cancel |

To access this dialog box, select Toolbar Options from the View menu. Use this dialog box
to control display options on the NetBackup Browser.

Show toolbar Shows the NetBackup toolbars.
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Show tool tips Shows tool tips. When the mouse pointer moves over the different
elements of the NetBackup Browser, the tool tips appear.

Flat Toolbars When selected, the main (or horizontal) toolbar buttons are displayed
as two-dimensional buttons. If not selected, buttons are displayed as
three-dimensional buttons.

Large Buttons When selected, large button icons and text are shown on the toolbar
buttons. If not selected, only small icons are shown on the buttons.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Backup Class and Schedule Dialog Box

This section explains the property sheets found in the Backup Class and Schedule dialog
box.

Backups Property Sheet

Backup Class and Schedule B
Backups |
Backup Class:
-
Backup Scheduls:
Iany
Archive Class:
Iany
Archive Schedule:
Iany
QK I Cancel | Help |

To access this property sheet:
1. From the Backup menu, select Specify Class and Schedule.

2. Click the Backups tab to open the property sheet.
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Use this property sheet to specify specific class and schedules to use when you start a
backup from the client.

Backup Class Specify the class to use for user-directed backups of this
client. If you set this value to any (default), NetBackup uses
the first class that it finds with both the client name and a
user-directed backup schedule.

Backup Schedule Specify the schedule to use for the user-directed backups for
this client. If you set this value to any (default), NetBackup
uses the first user-directed backup schedule in the first class
that it finds with both the client name and a user-directed
backup schedule.

Archive Class Specify the class to use for user-directed archives of this client.
If you set this value to any (default), NetBackup uses the first
class that it finds with both the client name and a
user-directed archive schedule.

Archive Schedule Specify the user-directed archive schedule to use for
user-directed archives of this client. If you set this value to
any (default), NetBackup uses the first user-directed archive
schedule in the first class that it finds with both the client
name and a user-directed archive schedule.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without
accepting changes to the parameters in this dialog box, click
this button.

Help To view online help for this dialog box, click this button.
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Search Backups Dialog Box

Search Backups B
Search Folder:
E

W Perform case-insensitive search

Kepword Phraze [optional):

Start Date:

I 8/24/1999 2:03:03 AM
End Date:

=]

IS;"BDJ‘I 993 10:36:15 PM

Search I Cancel |

=]

Help |

To access this dialog box:

0O From the Restore menu, select Search Backups

O From the NetBackup Restore window toolbar, select Search Backups

Use this dialog box to narrow the backup history search parameters for your restore.

Search Folder

Shows the folder or registry key for which you are searching. The
initial value for the Search Folder is “:\”. If you select a folder in the
NetBackup Restore window, that folder becomes the new default.

To change the path, enter a new value and press Return.

If you enter a full path name, NetBackup will search for the specific
path and file in the selected backup images. Or you can enter only the
filename (csb. t mp or *. t np) and NetBackup will show, in the All
Folders pane, the folders where the specified files were found.

You can use these wildcard characters:
*
?

Helpful Hint: Before initiating a search, collapse the tree in the All
Folders pane as much as possible. NetBackup will expand the tree to
the folders that match your search criteria.
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Perform case Select Perform case insensitive search to perform case insensitive
insensitive search searches.

The search path is case sensitive and must match what is in the
database on the NetBackup server. When the Perform case insensitive
search checkbox is selected, NetBackup can start a case insensitive
search. By default the checkbox is not checked.

Keyword Phrase Enter a keyword phrase associated with a backup image.

(Optional)

Start Date and View and select the Start Date and the End Date. The Start Date and

End Date End Date show the range of backups that NetBackup will search. By
default, the start date will be the time of the last full backup and the
end date will be the time of the most-recent backup.

To change the dates, click in the box and select from the list of
available backup images.

If you change the Start Date or End Date, NetBackup clears all the
restore selections that you have previously made.

Search Initiates a search for specified files, folders, or registry keys. The
NetBackup Restore window will show the folders that match the
search criteria.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Specify Backup Options Dialog Box

Specify Backup Options m
% Backup to MetBackup server: Iwindows j

General Options |

Items marked to be backed up:

M ame

C:\Program Files\WERITAS \MetB ackup'\Readme. bt

[ Archive files [delete files after successhul backup)

Keyword phrase to azzociate with the backup [optional]

Start Backup I LCancel Help

To access this dialog box:

0O Click the Backup button on the NetBackup Backup window.

0O From the Backup menu, select Backup Marked Files.

Backup to
NetBackup
Server

List box

Archive files
(delete files after
successful
backup)

Keyword Phrase
to Associate With
the Backup
(Optional)

Start Backup
Cancel

To change the NetBackup server that will perform the backup
operation, select another server from the drop-down list.

Contains a list of objects to be backed up.

Select to perform an archive instead of a backup. Files or folders will
be deleted after they have been backed up successfully.

Specifies a keyword phrase, up to 128 characters in length, that
NetBackup will associate with the image created by this backup
operation. You can then restore the image by specifying the keyword
phrase in the Search Backups dialog box.

All printable characters are permitted including space (* ”’) and period
(““.”). The default keyword phrase is the null (empty) string.

Initiates the backup or archive operation.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.
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Help To view online help for this dialog box, click this button.

Restore Marked Files Dialog Box

Restore Marked Files B
Restore Marked Files |
r~ Restare Destination Chaoice
@& Restore evenything to its original location
 Restore evenything to a different location [maintaining existing structure):
Source:
Destination:
I Browse... |
€ Restore individual folders and files to different locations [double-click to madify):
Source | [ estination I Time Bacl
C:\Program Files\YERITAS M etB ackuphR eadmelCl bt 34284007
< | o]
r Restore Option:
If
(:. -
[ temporary filename
7 Do nok restore the fil
Start Restore I Cancel | Help |

This dialog box appears after you have initiated a restore operation. Use this dialog box to
view your selections before proceeding with the operation. If the list is longer than the list
box, a vertical scroll bar appears along the right edge of the pane.

Restore This pane contains radio buttons which determine the destination for
Destination restored files. The user must choose one of the radio buttons in the
Choices pane.

Restore Restore files, folders, or registry keys to the folder from which they

everything to  were backed up. This is the default.

its original

folder

Restore Enter the alternate folder you want to use to restore files, folders, or

everything to a registry keys.

different

location

Source Enter the path from which the files, folders, or registry keys was

backed up.
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Destination Enter the path to which the files, folders, or registry keys will be
restored.

By default, the lowest level folder common to all the items being
restored appears in the Source box. If this is changed to a folder that
only contains some of the items, only those items will be restored to
the folder specified in the Destination box. All other items will be
restored to their original location.

Browse This button is enabled when the Restore everything to a different
location checkbox is selected. Click this button to open the Browse for
Folder dialog box. You can then select a destination folder.

Note: You will be browsing the local machine where the NetBackup
browser is running, even if you are performing an alternate client

restore.
Restore Restore files, folders, or registry keys to an alternate path on a file by
individual file, folder by folder, or registry key by registry key basis. The default
folders and is to restore to the original path.

files to different

: Select this option, then double-click on an item in the list, and the
locations

Enter New Destination dialog box will pop up on top of the Restore
Marked Files dialog box. In the new dialog box, you can either
manually enter a new destination path, or press a browse button to
browse for a new destination path. If you select OK, that path will
then show up in the “Destination” field of the list for that item.

The individual items you marked for restore will appear in the
Restore individual folders and files to different locations list box. If you
mark a folder to be restored, that folder name, not the individual files,
will appear in the list box. To be able to restore individual files to
different locations, files must be selected individually.

Restore Options  This pane contains radio buttons which specify how to restore files,
folders, or registry keys onto a system which may contain files,
folders, or registry keys with identical names. The user must choose
one of the radio buttons in the pane.

Overwrite the  Overwrites existing files, folders, or registry keys. The default is to not
existing file overwrite. In this mode, the restore does not occur if the files, folders,
or registry keys exist.

Select Overwrite the existing file to overwrite existing files, folders, or
registry keys.
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Restore the file NetBackup will rename a file so as not to copy over an existing file.

using a
temporary
filename

Do not restore

the file

Start Restore
Cancel

Help

NetBackup will restore the item to f i | enaneXXXXXX. TMP, where
filename is the name of the file being restore and XXXXXX is
generated based on the current date and time. This option is only
valid when the restore has been requested by, and performed on, the
same machine. This option is not supported by server directed
restores.

This is the default.

Initiates the restore operation.

To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

To view online help for this dialog box, click this button.

NetBackup Client Job Tracker Dialog Box

MNetBackup Client Job Tracker B

Job D |

Job T_l,lpel

Statug I

Time Startedl

Time Stoppedl

Current File Mame I

Current File Sizel Bytes
- Actual

Filesl KBytes Datal
Falders I KEBytes Image I
KBytes.-"Sec:I

r Estimated
Filesl KBytes Datal
Falders I KEBytes Image I

Pranvious: Mest
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To open the NetBackup Client Job Tracker dialog right click on the NetBackup Client icon
in the system tray and select Details. If Details is disabled, there have not been any
backups or restores since the NetBackup Client Job Tracker was started. If the NetBackup
Client icon is not in the system tray, click Start and choose VERITAS NetBackup and
NetBackup Client Job Tracker.

NetBackup Client Job Tracker’s purpose is to inform the user that a backup or restore is
being done on the client machine. The NetBackup Client Job Tracker gives an estimate of
the size of the job. It is not intended to replace the View Status dialog box available
through the NetBackup Browser or the Activity Monitor available through the NetBackup
Server.

Once the NetBackup Client Job Tracker is started, it reports on server directed operations,
scheduled operations, and user operations. When the NetBackup Client Job Tracker is
shut down, it “forgets” about the jobs it has been tracking (this includes logging off the
system).

Job Tracker only reports on the status of a backup as it is running on the client. Once a
backup is sent to the NetBackup Server, it will not update the status of that job. Example:
the client sends all of the data to be backed up to the server successfully. It reports the
backup status as Successf ul . Later an error occurs on the server which causes the backup
to fail, the status shown by the Job Tracker is not updated.

Job ID Displays the NetBackup Job ID.

Job Type Shows the type of NetBackup operation for the selected job: backup,
archive and restore.

Status Displays the progress of the selected operation.

Time Started Displays the time the NetBackup operation started.

Time Stopped Displays the time the NetBackup operation stopped.

Current File Displays the name of the file currently being backed up, archived, or

Name restored.

Current File Size Displays the size in bytes of the file currently being backed up,
archived, or restored.

Actual Displays the status of the NetBackup operation.
Files Displays the number of the files currently backed up, archived, or
restored.
Folders Displays the number of folders backed up. A folder is counted each

time a file or sub folder contained in the folder is backed up.

KBytes Data  Displays the amount of data, in kilobytes, currently backed up,
archived, or restored. This is rounded to the nearest whole number, so
it is possible this number may be 0 if the number of bytes being
backed up is less then 500.
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KBytes Image Displays the current size, in kilobytes, of the image backed up or
archived.

KBytes/Sec Displays the rate of the NetBackup operation in kilobytes per second.

Estimated Displays an estimate of the finished NetBackup operation.
Files Displays the total number of files to be processed by the NetBackup
operation.
Folders Displays the number of folders being backed up. A folder is counted

each time a file or sub folder contained in the folder is backed up.

KBytes Data  Displays the total amount of data, in kilobytes, to be processed by the
NetBackup operation. This is rounded to the nearest whole number,
so it is possible this number may be 0 if the number of bytes being
backed up is less then 500.

Previous Shows the operating status of the previous NetBackup operation in
the queue.
Next Shows the operating status of the next NetBackup operation in the
queue.
OK Closes the NetBackup Client Job Tracker dialog box.
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This section contains information for the NetBackup Administrator.

Free Browse

The Free Browse feature allows users without restore privileges to restore from scheduled
backups. In previous versions of NetBackup, when a scheduled backup was performed by
a system administrator using a root user id, the client user was not able to restore from
that backup. The Free Browse feature allows the user to use a scheduled backup to restore
files. The user will be able to restore only those files to which they have write access.

There are three different settings - Use, Deny, and Allow.

0O When the client is set to Use, the user will be allowed to browse scheduled backups if
the NetBackup server is set to Allow or Use.

0O When the client is set to Deny, the user will not be allowed to browse backups no
matter how the NetBackup server is configured.

O If the client is set to Allow, the user will be able to browse scheduled backups if the
NetBackup server is set to Use.

The NetBackup master server setting is configured using the bpcl i ent command.

Note By default, the NetBackup master server setting is set to Allow.

To set Use:

# bpclient <clientname> -free_browse 2
To set Deny:

# bpclient <clientname> -free_browse 1
To set Allow:

# bpclient <clientname> -free_browse 0
To verify the configuration:

# bpclient <clientname> -L
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The following table displays the different combinations.

NetBackup Client NetBackup Use 'Free
Server Browse’
Deny Deny No
Deny Allow No
Deny Use No
Allow Deny No
Allow Allow No
Allow Use Yes
Use Deny No
Use Allow Yes
Use Use Yes

The Free Browse feature will only be used when either the NetBackup client or the
NetBackup server has been configured to Use it, and neither have been set to Deny it. By
default, all users get the Allow privilege.

In order to make use of the feature on the client, two registry keys need to be created using
the NT r egedt 32. exe utility.

1. Use the registry editor to create the following two keys.

" HKEY _LOCAL_MACHI NE\
SOFTWARE\
VERI TAS\
Net Backup\
Cur r ent Ver si on\
Securi ty\
Fr eeBr owse\
Use’

and

" HKEY_LOCAL_MACHI NE\
SOFTVWARE\
VERI TAS\
Net Backup\
Current Ver si on\
Securi ty\
Fr eeBr owse\
Deny’ .
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2. Set the user share permissions on each key.

3. Enter a data value for each key with the name of Flag (type = DWORD). Only when a
key has a non-zero Flag value will that privilege be turned on. If both of the Flag
values are zero, then all users will get the Allow privilege.

For example:

O If USERA has read access to the Deny key and the Flag value is non-zero, then
USERA will get the Deny privilege.

O If USERA has read access to the Use key and the Flag value is non-zero, then
USERA will get the Use privilege.

0O If USERA has read access to both the Use and Deny keys and they both have Flag
values of non-zero, then USERA will get the Use privilege.

0O If USERA has read access to both the Use and Deny keys and the Use key has a
Flag value of zero and the Deny key has a Flag value of non-zero, then USERA
will get the Deny privilege.

0O If USERA does not have any access to either the Use and Deny keys, then USERA

will get the Allow privilege no matter what the values of Flag.
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Alternate Client Restores

The administrator on the NetBackup master server can use the Backup, Archive, and
Restore interface on that server to direct a restore to any client of the same type that
backed up the files. However, it is not possible to perform a server-directed restore
through a database-extension product such as NetBackup for Oracle.

To prevent server-directed restores, either add or delete settings on the client as specified
in the table below.

Client Type Location of Setting To Prevent Server
Directed Restores
Microsoft Windows General tab in NetBackup Configuration dialog  Clear Allow server
95/98/NT/2000 box on the client (click Configure on the Actions directed restores box
menu to display this dialog box)
UNIX [ usr/ openv/ net backup/ bi n/ bp. conf Add
Dl SALLOW SERVER _
FI LE WRI TES
Macintosh / Net Backup Adnmi n/ Configuration Files Add
Di st/ bp. conf DI SALLOW SERVER _
FI LE_WRI TES
NetWare General tab in NetBackup Configuration dialog  Clear Allow server

(Target and Non-Target) box on the client (click Configure on the Actions directed restores box
menu to display this dialog box)

IBM OS/2 c:\veritas\netbackup\ bp.ini Delete
Al | ow Server _
Wite
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v To restore files to another client (server directed restore):
1. Log on to the master server as administrator.

2. Start the NetBackup Administration Program.

NetBackup Administration
Start Images ¥Yiew Help

File Actions Yiew Help

“iew Statuz | &

B Select for Backup | B Select for Restore -

Feady él

4. On the Actions menu, point to Select Files and Folders to Restore and on the
submenu, select the type of restore from those listed (From backup, From archived
backup, and so on).
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The Restore window appears (Restore from backup window in this example).

%3 Backup, Archive, and Restore - NetBackup - Restore: Server: windows Source Client: conan Destination Client: conan B[] B

g Restore: Server: windows Source Client: conan Destination Client: conan

= 31 30 29 28 27 2 2% 24 23 22 21 20 13 18 17 16 15 14

13
e e & e & O e e & °

Cantents of ‘conan’

8
e B [ [ [ [ [ e © L=
= il
= ;
All Folders

= 0B conan
o

Name | Time Backed Up_| Atributes | Size | Time Modified
=C = 0

O=C 9/8/391028:33PM d-r
O=D 9/8/991029:33PM d-r 0

Ready

5. Follow these instructions to set up an alternate client restore.

a. On the Actions menu, click Specify NetBackup Machines.

The NetBackup Restore Options dialog box appears.

Specify NetBackup Machines
Servers | Source Clients | Destination Clients |

MNew Serer Name:

Senver List:
conan(CUBREMNT)
windows

carrot

hippo

slater

Bemaowve | Make Currentl

v Use this server list for future backup and restore windows

oK I Cancel | Help |

b. Select the server that you are using and click Make Current. In this example, we

select conan.

- g
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c. Select the Source Clients tab.

Specify NetBackup Machines
Servers Source Clients |Qestination Clients |

MNew Client Name:

Client List:

cohan
ik

IV Use this client list for future backup and restore windows

Class Type:
[MS-windows-NT

Add
ke Eurrent |
=

oK | Cancel | Help

d. Select the client whose backup image you are going to restore files from. In this
example, we select lobo.

e. Select the Destination Clients tab.

Specify NetBackup Machines
ger\xers| Source Clients  Destination Clients |
MNew Client Name:
Add
Client List:
hawk(CLIRBRENT)
lobo
cohan
ke Eurrent |
oK Cancel Help |
R . ———
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f.  Select the client to which you are going to restore the files. In this example, we
select hawk.

g. Click OK.
6. Open the NetBackup Restore Window and select files for restore.
7. Click Start Restore. The Restore Marked Files dialog box appears.

8. Follow these instructions to restore to a path other than the one from which the files
were originally backed up.

a. Inthe Restore Marked Files dialog box, select Restore Everything To a Different
Location.
b. Enter the alternate restore path in the Destination box.

The paths in the Source and Destination boxes must use the formats required by the
clients as shown in Table 4.

Note When restoring to a UNIX client, you must use the Windows NT format. For
example, to restore a file from / et ¢ to/ t np, you specify et ¢: \ as the source and
t mp: \ as the destination.

Table 4. Restore Path Formats

Client Path Format Example
UNIX directory:\ usr:\openv\netbackup\
Macintosh folder/folder/ NetBackup Admin/Configuration Files Dist/
Microsoft Windows, drive:\directory\ c:\Veritas\NetBackup\
NetWare Non-Target
NetWare Target /target/volume/data_pat /SYS/MARGE/veritas/netbackup/
h
IBM OS/2 drive:\directory c:\veritas\netbackup
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In this example, we are restoring a file from one Windows NT client (lobo) to
another Windows NT client (hawk) and specify the path where the files will go on
hawk.

Restore Marked Files

—Restore Destination Choices
 Restore evandhing to its original location

& Restore evandhing to a different location (maintaining existing structure):

Source:

IC:\

Destination:

ID\ithpl Browse... |

 Restore individual folders and files to different locations (double-click to modify):

Source | Destinationl Time Backed Up | Time Modified |
CAIDEYE 8/29/99 419:48 AM 10/6/97 11:37:38 P

—Restore Options
If the destination file already exists:
 Owerwrita the existing file
 Restore the file using atamporary filename

& Do not restore the fila
Start Restare I Cancel Help

9. Click Start Restore to start the restore.
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NetBackup Specify NetBackup Machines Dialog Box for System
Administrators

When the current window is a Restore window and the Specify NetBackup Machines
dialog is opened on a NetBackup server, three property sheets are displayed:

O Servers
O Source Clients

O Destination Clients

Specify NetBackup Machines - Servers Property Sheet

Refer to “Servers Property Sheet” on page 61 for more information.

Source Clients Property Sheet

Specify HetBackup Machines m

Servers | Source Clients | Destination Clients I

Mew Client Mame:

Cliert List:
hippo[CURRENT)
pary

pig

Make Cumant |

V! Use this client list for future backup and restore windows

Clazs Type:

[MS Windaws-NT ~|
QK I Cancel | Help |

To access this dialog box:
1. Make a Restore window active.
2. From the Actions menu, choose Specify NetBackup Machines.

3. Select the Source Clients property sheet.

Use this dialog box to select the client whose backups you want to restore. Files or folders
that were backed up or archived from one NetBackup client can be restored to a different
NetBackup client. This is called an alternate client restore.
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Notes:

O The NetBackup master server must be configured to allow alternate client restores.
(Refer to the section on server directed restores in the NetBackup System
Administrator’s Guide - UNIX or the NetBackup System Administrator’s Guide -
Windows NT/2000 for details.)

O For information on file permissions required, see page 5

New Client Name To add another client name to the Client List, type the name of the
client in the New Client Name and click Add. The client name entered
must also be defined in a class on the NetBackup server. If a new
client is added to the list it will be in the client list for all windows
currently opened and any new window that is opened. The new client
will be saved in the Client List box after the current window is closed.

Add Adds the client, entered in the New Client Name box, to the Client List.

Client List The Client List shows the names of the NetBackup clients that your
client can access. To change the name of the client whose backups you
can browse for files to restore, select a name from the Client List and
click Make Current. The word CURRENT now appears in parentheses
beside the name of the new source client.

Make Current Designates the client backup images you can browse for restore
operations. First highlight the client in the Client List, then click Make
Current. Changing the current client will affect only the selected
window. This setting will not be saved after the currently selected
window is closed.

Use this client list If selected, NetBackup applies any changes to the client list to all
for future backup backup and restore windows opened after the property sheet

and restore modifications have been saved.
windows
Class Type View and select class type for the client selected in the Client List. The

class type must be the same as specified for the client in the
NetBackup configuration on the NetBackup server.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Destination Clients Property Sheet

Specify HetBackup Machines m
§ervers| Source Clients | Destination Clients |
Mew Client Mame:
Add
Cliert List:
hippo[CURRENT)
pig
zucchini
panzy
Make Cumant |
QK I Cancel | Help |

To access this dialog box:
1. Make a Restore window active.
2. From the Actions menu, choose Specify NetBackup Machines

3. Select the Destination Clients property sheet.

Use this dialog box to select the client which will receive the restored backups. Restoring
files to another client is a type of server directed restore.

Notes:

O The NetBackup master server must be configured to allow alternate client restores.
(Refer to the section on server directed restores in the NetBackup System
Administrator’s Guide - UNIX or the NetBackup System Administrator’s Guide -
Windows NT/2000 for details.)

O For information on file permissions required, see page 5.

O Aclient can prohibit server directed restores by clearing the Allow server-directed

restores option on the General property sheet in the Configure dialog. See “General
Property Sheet” on page 54.
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New Client Name To add another client name to the Client List, type the name of the
client in the New Client Name and click Add. The client name entered
must also be defined in a class on the NetBackup server. If a new
client is added to the list it will be in the client list for all windows
currently opened and any new window that is opened. The new client
will be saved in the Client List box after the current window is closed.

Add Adds the client, entered in the New Client Name box, to the Client List.

Client List The Client List shows the names of the NetBackup clients that your
client can access. To change the name of the client whose backups you
can browse for files to restore, select a name from the Client List and
click Make Current. The word CURRENT now appears in parentheses
beside the name of the new source client.

Make Current Designates the client that will receive the restore operations. First
highlight the server in the Client List, then click Make Current.
Changing the current client will affect only the selected window. This
setting will not be saved after the currently selected window is closed.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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NetBackup Configuration Dialog Box

This section contains information on the NetBackup Configuration dialog box for the
system administrator.

Configuration information is kept in the registry key
\ HKEY_LOCAL_MACHI NE\ Sof t war e\ VERI TAS\ Net Backup
\ Curr ent Ver si on\ Confi g.

General Property Sheet

MetBackup Configuration m
Metwork, | Wirus Protection | TroubleShoating |
General | Exclude List | Include List | Backups
Client name:
|M
Lizt files timeout: Restore refries:
300 o5 seconds 0 =
Time overlap: User-directed operation timeout:

[=11] ;I mirutes IBD _I:j seconds

Keep statuz of uger-directed backups,
archives, and restores for:

|3 _I:j days

V¥ Perform incrementals bazed on archive bit
¥ Allow server-directed restores

W Perform default search

QK I Cancel | Help |

To access this property sheet:
1. From the Actions menu, select Configure.

2. Click the General property sheet.

Use this property sheet to set any of the configuration parameters for your client.

Client name This parameter should be changed only by a system administrator.
Specify the NetBackup client name of your client. This name is used
when backing up, archiving and restoring files, folders, or registry
keys. The client name in NetBackup server class configuration must
match the client name specified here.
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List files timeout  This parameter should be changed only by a system administrator.
Specify the number of seconds to wait for a response from the
NetBackup master server when listing files. If this amount of time is
exceeded, the user receives the socket read failed error even if the
server is still processing the user’s request. The default is 300 seconds.
The minimum setting is zero. The maximum setting is 36,000 seconds.

Restore retries ~ This parameter should be changed only by a system administrator.
Specify the number of times to retry a restore after a failure. The
default is zero, which is no retries. The maximum setting is 999.

Time overlap This parameter should be changed only by a system administrator.
Specify the extra number of minutes to add to the date range for
incremental backups when using date based backups. This value can
be used to compensate for differences in the speed of the clock
between the client and NetBackup server. The default is 60 minutes.
The minimum setting is zero. The maximum setting is 1,440 minutes.

User-directed Specify the number of seconds to wait for a response from the
operation NetBackup master server when performing user-directed operations.
timeout: If this amount of time is exceeded, the user receives the socket read

failed error even if the server is still processing the users request. The
default is 60 seconds. The minimum setting is zero. The maximum
setting is 36,000 seconds.

Keep status of Specify the number of days to store progress reports before the system
user-directed will automatically delete them. Default is 3 days. The minimum
backups, allowable value is zero. The maximum is 9,999.

archives, and

restores for:
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Perform This parameter should be changed only by a system administrator.
incrementals Select this check box to have NetBackup include files in an

based on archive incremental backup only if their archive bit is set. The system sets this
bit bit whenever a file is changed and it will remain set until NetBackup

clears it. A full backup always clears the archive bit. A
differential-incremental backup clears the archive bit if the file is
successfully backed up within the number of seconds indicated by
C ear _Archive Bit_Incr_Wit.Acumulative-incremental
backup or user backup has no effect on the archive bit.

Clear this checkbox to have NetBackup include a file in an
incremental backup only if the file’s datetime stamp has been changed
since the last backup. For a cumulative-incremental backup,
NetBackup compares the file’s timestamp against the last full backup.
For a differential-incremental backup, NetBackup compares the
timestamp against the last full backup or incremental backup.

If you install or copy files from another computer, the new files retain
the datetime stamp of the originals. If the original date is before the
last backup date on this computer, then the new files will not be
backed up until the next full backup, whichever is most recent.
Windows 95/98 and Windows NT/2000 clients use the create and
modify datetime stamp.

Allow This parameter should be changed only by a system administrator.

server-directed  Select this check box to let the administrator on the NetBackup server

restores initiate restores to this client. The default is to allow server directed
restores.

Perform default  If selected, NetBackup will automatically search the default range of
search backup images and display the backed up folders and files whenever
a restore window is opened.

Clear this box to disable the initial search. The NetBackup Restore
window will not show any files or folders when initially opened.
Clicking a backup image, or selecting a range of backup images, will
initiate a search.

By default, this box is selected.
OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Exclude List Property Sheet

MetBackup Configuration m
Metwork, | Wirus Protection | TroubleShoating |
General Exclude List | Include List | Backups
Class: I
Schedule: I
Exclude File: I
Add
Exclude File List:
Modify | Bemove |
Mew List | Dielete List | <4 Previoues | Megt > |
QK I Cancel | Help |

Note Parameters in this dialog box should be changed only by a system administrator.

To access this property sheet:
1. From the Actions menu, select Configure

2. Click the Exclude property sheet.

Use this property sheet to view and change the list of files to exclude from a master server
directed backup. For example, if you add C: \ *. bat to the Exclude File List, all files with
a. bat extension that appear in the root of the C. drive will not be backed up. If you want
to exclude all . bat files, use *. bat . Exclude lists only apply to full backups,
cumulative-incremental backups, and differential-incremental backups initiated by the
NetBackup server. Refer to “Syntax Rules for Exclude and Include Lists” on page 102 for
more details.

Exclude lists can be created for specific classes and schedules. The first exclude list has the
class and schedule disabled. The list cannot be deleted, but it can be empty.

Class The Exclude File List applies only to server directed backups for the
specified class.
Schedule The Exclude File List applies only to server directed backups for the

specified schedule. This requires that a class be specified.
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Exclude File Enter the file or folder, that you want to exclude, in the list box. Click
Add to move the file or folder to the Exclude File List.

The exclude list is case sensitive unless the case_sensitive_exclude_list
data value in the registry is set to no.
Add Click this button to add a file or folder to the Exclude List File.

Exclude File List The file list applies only to scheduled backups. It shows the names of
the files that will be excluded in a scheduled backup. To remove a file
from the list, select the name and click Remove.

Modify Select a list entry, then click this button to edit the selected file or
folder from the file list.

Remove Click this button to remove a selected file or folder from the file list.

New List Use this button to create a new list with a class and schedule.
Duplicates of class and schedule are not allowed.

Delete List Use this button to delete the current list.

Previous Use this button to view the previous list.

Next Use this button to view the next list.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting

changes to the parameters in this dialog box, click this button.
Help To view online help for this dialog box, click this button.

Include List Property Sheet

MetBackup Configuration m
Metwork, | Wirus Protection | TroubleShoating |
General | Exclude List Include List | Backups
Class: I
Schedule: I
Include File: ||
Add
Include File List:
Modify | Bemove |
Mew List | Dielete List | <4 Previoues | Megt > |
QK I Cancel | Help |
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Note Parameters in this dialog box should be changed only by a system administrator.

To access this property sheet:
1. From the Actions menu, select Configure

2. Click the Include property sheet.

Use this property sheet to make exceptions to the list of files that are excluded from a
server-directed backup (those files listed in the Exclude List). For example, if you want to
exclude all files with a . bat extension except the aut oexec. bat file from backups, you
would add *. bat to the Exclude File Listand aut oexec. bat to the Include List. Include
lists only apply to backups, initiated by the NetBackup master server. Refer to “Syntax
Rules” on page 102 for details.

Include lists can be created for specific classes and schedules. The first include list has the
class and schedule disabled. The list cannot be deleted, but it can be empty.

Class The Include File List applies only to server directed backups for the
specified class.

Schedule The Include File List applies only to server directed backups for the
specified schedule. This requires that a class be specified.

Include File Enter the file or folder, that you want to include, in the list box. Click
Add to move the file or folder to the Include File List.
The include list is case sensitive unless the case_sensitive_exclude_list
data value in the registry is set to no.

Add Click this button to add a file or folder to the Include List File.

Include File List  The file list applies only to scheduled backups. It shows the names of
the files that will be included in a scheduled backup. To remove a file
from the list, select the name and click Remove.

Modify Select a list entry, then click this button to edit the selected file or
folder from the file list.

Remove Click this button to remove a selected file or folder from the file list.

New List Use this button to create a new list with a class and schedule.
Duplicates of class and schedule are not allowed.

Delete List Use this button to delete the current list.

Previous Use this button to view the previous list.

Next Use this button to view the next list.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting

changes to the parameters in this dialog box, click this button.
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Help To view online help for this dialog box, click this button.

Network Property Sheet

General | Exclude List | Include List | Backups |
HMetwork, | Wirug Protection | TroubleShoating
MetBackup Client Service Port:
EE =
MetBackup Request Service Port:
’TI Cancel | Help |

Note Parameters in this dialog box should be changed only by a system administrator.

To access this property sheet:
1. From the Actions menu, select Configure.

2. Click the Network property sheet.

Use this property sheet to view and change the port numbers used during
communications between your client and the NetBackup master server.

NetBackup Client Specify the port the NetBackup server uses to communicate with the
Service Port: NetBackup client. The default is 13782.

NetBackup Specify the port to which the client should send requests to the
Request Service NetBackup request service, bpr d, on the NetBackup server. The
Port default is 13720.

OK To accept changes to the parameters, click this button.

Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.
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Troubleshooting Property Sheet

General | Exclude List | Include List | Backups |
Metwork, | Wirus Protection TroubleShoating
- Debug Level
General: TCP:
U= =
Heap: Flush :
bE (E=
Werboge: D atabase:
bE bE
’TI Cancel | Help |

Note Parameters in this dialog box should be changed only by a system administrator.

To access this property sheet:
1. From the Actions menu, select Configure.

2. Click the Troubleshooting property sheet.

Use this property sheet to view and change the amount of information that NetBackup
saves in its activity/troubleshooting logs. NetBackup only creates log files if the log
folders are created. See “Troubleshooting Logs” on page 101 for more details. Also see the
NetBackup Troubleshooting Guide - UNIX or the NetBackup Troubleshooting Guide - Windows
NT/2000 for information on using these logs.

General Controls the amount of information that NetBackup writes to the
troubleshooting logs. Supported values are 0, 1, or 2. The higher the
level, the more information is written. The default is 0.

Appendix A, System Administrators 9 Y



NetBackup Configuration Dialog Box

TCP Used for debug purposes and enables TCP debugging. Supported
values are:

0 No extra logging. This is the default.

1 Log basic TCP/IP functions.

2 Log all TCP/IP functions, including all read and write requests.
3 Log contents of each read/write buffer.

Note: Setting Debug TCP Level to 2 or 3 can cause the status reports to
be very large. It can also slow performance of a backup or restore
operation.

Heap Enables memory heap debugging. Supported values are:
0 No memory heap debugging information. This is the default.
1 Memory heap information at the start and end of program
2 Near memory heap information at the start and end of program.

3 Near and far memory heap information at the start and end of
program.

Flush NetBackup periodically flushes the progress reports on NetBackup
operations. This setting specifies the frequency of the flushes or how
often the internal buffer gets written to the progress report. The higher
the flush level, the more often the buffer is written to the file.
Supported values are 0, 1 or 2. The default is 0.

Verbose \Verbose controls the amount of information that the NetBackup NT
Server writes to its logs. This parameter is only in effect when the local
machine (where the NetBackup client is being run) is also a
NetBackup NT server.

The values can be 0 to 99.

Supported values are:

0 No extra logging. This is the default.
1- 99 Verbose logging.

Use the default setting of zero unless advised otherwise by VERITAS
Technical Support.

Database Controls the amount of information the NetBackup Database
Extensions write to their log files.

Supported values are 0 through 9. The higher the level, the more
information is written. The default is 0.

OK To accept changes to the parameters, click this button.
N A _ R
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Cancel To cancel and return to the previous display without accepting
changes to the parameters in this dialog box, click this button.

Help To view online help for this dialog box, click this button.

Troubleshooting Logs

NetBackup will generate troubleshooting logs only if you create the following folders on

your client.

Windows NT/2000

C\

\ VERI TAS
\Program Fil es
\ Net Backup
\l ogs

\ BPBKAR
\ BPCD
\ BPI NETD
\ NBW N
\ TAR

Windows 95/98

C\

\ VERI TAS
\Program Fil es
\ Net Backup
\l ogs

\ BPCD
\ NBW N

All log files use the format yymdd. LOG

BPBKAR Log files in this folder contains info about backups, both user and
server directed.

BPCD Log files in this folder have information useful for troubleshooting
communications between your NetBackup client and the NetBackup
server.

BPI NETD Log files in this folder have information on the NetBackup Client
Service operation.

NBW N Log files in this folder have information on user operations.

TAR Log files in this folder contain information about restores, both user
and server.
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Note If you use Notepad to view the log files, the file will appear as one long line.
Wordpad recognizes the line breaks and properly displays the lines.

Syntax Rules for Exclude and Include Lists

Syntax Rules
The following syntax rules apply to exclude lists and include lists.
O Only one pattern per line is allowed.

0O The following meta or wildcard characters are recognized:

[]
2

*

O To use the wildcard characters literally (that is, as non wildcard characters), precede
them with a backslash (\). For example, assume that the brackets in the following
example are not being used as wildcards:

\ hone\ abc\ f un[ ny[ nane
In your exclude list, precede the brackets with a backslash as in
\ hone\ abc\ fun\ [ ny\ [ nane

to have NetBackup interpret the brackets literally.

Note Note that a backslash (\) acts as an escape character only when it precedes a
wildcard as in the above example. This means that NetBackup normally interprets a
backslash literally and it is a legal character to use in pathnames.

O Spaces are considered legal characters. Be careful to omit extra spaces unless they are
part of the file name.

For example, if you want to exclude a file named
C.\hone\testfil e (with no extra space character at the end)
and your exclude list entry is
C.\hone\testfil e (with an extra space character at the end)

NetBackup will not be able to find the file until you delete the extra space from the
end of the file name.
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O End a file path with \ to exclude only folders with that path name (for example,
C.\ hone\t est\). If the pattern does not end in \ (for example, C: \ usr\t est)
NetBackup excludes both files and folders with that path name.

O To exclude all files with a given name, regardless of their folder path, just enter the
name without a preceding slash. For example:

t est
rather than
C \test
This is equivalent to prefixing the file pattern with
C\
C\*\
CA*\*\
[CARARARA

and so on.

Example of an Exclude List
If an exclude list has the following entries:
C: \ hone\ doe\ j ohn
C: \ hone\ doe\ abc\
C:\ hone\ *\ t est
C\*\tenmp
tenp
the following are excluded from server directed backups:
O The file or folder named C: \ hone\ doe\ j ohn.
O The folder C: \ hone\ doe\ abc (because the exclude entry ends with \).
O Allfiles or folders named t est that are two levels below home.
O Allfiles or folders named t enp that are two levels below the root.

O Allfiles or folders named t enp at any level.
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This section describes commands specific to the NetBackup product. Execute these
commands in an MS-DOS window so you can see the results.

The following are special conventions used in the command descriptions.

g
g

g

Brackets [ ] mean that the enclosed command line component is optional.

A vertical bar (or pipe) symbol | separates optional arguments from which the user
can choose. For example, assume that a command has the following format:

command [argl | arg2]
Here, the user can choose either argl or arg2 (but not both).

Italics indicate that the information is user supplied. For example, the user supplies
class, schedule, and filename in the following command:

bpbackup - c class - s schedule flename

An ellipses (...) means that you can repeat the previous parameter. For example,
consider the following command:

bpbackup [- S master_server [,master_server,...]] filename

Here, the - S option requires the first master server name. Additional names can be
added, separated by commas and followed by a file name as in:

bpbackup -Snars, coyot e, shark, m nnow nenofil e. doc
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bparchive

NAME

bparchive - archive files to the NetBackup server

SYNOPSIS

install_path\ Net Backup\ bi n\ bparchive [-c class] [-s schedule] [-S
master_server [ , master_server,...]] [-t class _type] [-L
progress _log] [-w [hh: mm:ss]] [-help] [-k
"keyword_phrase"] -f listfile | filenames

DESCRIPTION

bpar chi ve processes files that you list on the command line or in the file you specify
with the - f listfile option. Any file path entered can be a file or directory name. If the list of
files includes a directory, bpar chi ve archives all files and subdirectories of that directory
starting at the directory itself.

By default, you are returned to the system prompt after bpar chi ve is successfully
submitted. The command works in the background and does not return completion status
directly to you. The - woption lets you change this behavior so bpar chi ve works in the
foreground and returns completion status after a specified time period.

bpar chi ve writes its informative and error messages to a progress-log file. You must
create this file prior to the execution of the bpar chi ve command and then specify it with
the - L progress_log option. If bpar chi ve cannot archive any of the requested files or
directories, you can use the progress log to determine the reason for the failure.

If you create an install_path\ Net Backup\ | ogs\ bpar chi ve\ directory with write
access, bpar chi ve creates an activity log file in this directory that you can use for
troubleshooting.

The following restrictions apply to this command;

O To archive files with the bpar chi ve command, you must have permission to delete
the file and the file must not be read-only. Otherwise, NetBackup saves the files but
does not delete them from the disk.

O bpar chi ve does not archive the "." or ".." directory entries, and does not archive
disk-image backups.
OPTIONS

-c class Names the class to use for the user archive. If it is not specified, the
NetBackup server uses the first class it finds that includes the client and a
user archive schedule.
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- s schedule
Names the schedule to use for the user archive. If it is not specified, the
NetBackup server uses the first user archive schedule it finds in the class
it is using (see the - ¢ option).

S master_server [ , master_server,. . . |
Specifies the name of the NetBackup master server. The default is the
server designated as current on the Servers tab of the Specify NetBackup
Machines dialog box. To display this dialog box, start the user interface
on the client and click Specify NetBackup Machines on the Actions menu.

-t class_type
Specifies one of the following numbers corresponding to the class type
(the default is 0 on all clients except Apollo, where the default is 3):

0 = Standard

4 = Oracle

6 = Informix-On-BAR
7 = Sybase

10 = NetWare

13 = MS-Windows-NT
14 =0S/2

15 = MS-SQL-Server
16 = MS-Exchange-Server
19 =NDMP

Note The following class types (Apollo-wbak, DataTools-SQL-BackTrack,
Auspex-FastBackup, SAP, DB2, FlashBackup, Split-Mirror, and AFS) apply only to
NetBackup DataCenter.

3 = Apollo-wbak
11 = DataTools-SQL-BackTrack
12 = Auspex-FastBackup
17 =SAP
18 =DB2
20 = FlashBackup
21 = Split-Mirror
22 = AFS
-L progress_log

Specifies the name of an existing file in which to write progress
information.

For example: c: \ pr ogl og.
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The default is to not use a progress log.

-w [ hh: mm: ss]

-hel p

Causes NetBackup to wait for a completion status from the server before
returning you to the system prompt.

You can optionally specify a wait time in hours, minutes, and seconds.
The maximum wait time you can specify is 23:59:59. If the wait time
expires before the archive is complete, the command exits with a timeout
status. The archive, however, still completes on the server.

If you use - wwithout specifying the wait time or if you specify a value of
0, NetBackup waits indefinitely for the completion status.

Displays a synopsis of command usage when it is the only option on the
command line.

-k keyword_phrase

-f

listfile

Specifies a keyword phrase that NetBackup associates with the image
created by this archive operation. You can then restore the image by
specifying the keyword phrase with the - k option on the bpr est or e
command.

The keyword phrase is a textual description of the archive that is a
maximum of 128 characters in length. All printable characters are
permitted including space (" ") and period ("."). Enclose the phrase in

double quotes ("...") or single quotes (*...").
The default keyword phrase is the null (empty) string.
Specifies a file (listfile) containing a list of files to be archived and can be

used instead of the filenames option. In listfile, place each file path on a
separate line.

The format required for the file list depends on whether the files have
spaces or returns in the names.

To archive files that do not have spaces or returns in the names, use this
format:

filepath

Where filepath is the path to the file you are archiving. For example:

c:\ Prograns

c:\winnt

c:\docunent s\ ol d_nenos

To archive files that have spaces or returns in the names, use this format:
filepathlen filepath

Where filepath is the path to the file you are archiving and filepathlen is
the number of characters in the file path.

For example:
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11 c:\ Prograns
8 c:\winnt
22 c:\docunents\ol d nmenps

filenames
Names one or more files to be archived and can be used instead of the - f
option.
Any files that you specify must be listed at the end, after all other options.
EXAMPLES
EXAMPLE 1

To archive a single file, enter:

bparchive c:\usr\user1\filel

EXAMPLE 2
To archive files listed in a file named ar chi ve_1 i st , enter:

bparchive -f archive |ist

EXAMPLE 3

To associate the keyword phrase "Archive My Home Directory 01/01/97" to the archive of
the directory c¢: \ hone\ kwe and use a progress log named c: \ honme\ kwe\ ar ch. | og
enter the following (all on one line):

bparchive -k "Archive My Hone Directory 01/01/97" -L
c:\honme\ kwc\arch.log c:\hone\kw

FILES

install_path\ Net Backup\ | ogs\ bpar chi ve\*. | og
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NAME

bpbackup - back up files to the NetBackup server

SYNOPSIS

install_path\ Net Backup\ bi n\ bpbackup [-c class] [-s schedule] [-S
master_server [ , master_server,...]] [-t class _type] [-L
progress _log] [-w [hh: mm:ss]] [-help] [-k
"keyword_phrase"] -f listfile | filenames

install_path\ Net Backup\ bi n\ bpbackup -c¢ class -i [-h hostname] [-s
schedule] [-S master_server [, master_server,...]] [-t
class type] [-w [hh:mm:ss]] [-k "keyword phrase"]

DESCRIPTION
bpbackup starts either of the following:

g

A user backup that is the equivalent to what is performed by using the interface on
the client (see the first form of the command shown above). This type of backup can
be started from any NetBackup client in order to back up files from that client.

The bpbackup command processes the files that you list on the command line or in
the file that you specify with the - f listfile option. A file path can be a file or directory
name. If the named files include a directory, bpbackup backs up all files and
subdirectories of that directory starting at the directory itself.

An immediate-manual backup of a client (see the second form of the command shown
above). This variation requires the - i option on the bpbackup command and is
available only to the administrator on the master server. It is the equivalent starting a
manual backup from the NetBackup administrator’s interface. Use the - h option to
specify the host.

The following restrictions apply to this command;

g

g

You must be the owner of the file or an administrator to back up a file with
bpbackup.

You can back up files and directories owned by other users if you have the necessary
permissions.

bpbackup does not back up the "." or ".." directory entries.

By default, you are returned to the system prompt after bpbackup is successfully
submitted. The command works in the background and does not return completion status
directly to you. The - woption lets you change this behavior so the command works in the
foreground and returns completion status after a specified time period.
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bpbackup writes informative and error messages to a progress-log file if you create the
file prior to the execution of the bpbackup command and then specify the file with the - L
progress_log option. If bpbackup cannot back up the requested files or directories, use
the progress log to determine the reason for the failure.

If you create a directory named install_path\ Net Backup\ | ogs\ bpbackup with write
access, bpbackup creates an activity log file in this directory that can be used for
troubleshooting.

OPTIONS

-c class Names the class to use for the backup.

If this option is not specified for a user backup, NetBackup uses the first
class it finds that includes the client and a user backup schedule.

The - ¢ option is required for an immediate-manual backup (- i option).

- Starts an immediate-manual backup. This is the equivalent of starting a
manual backup from the NetBackup administrator interface. You must be
the administrator on the master server to use the - i option.

- h hostname
Use this option only in conjunction with the - i option. It names the client
host on which to run the backup. If it is not specified, NetBackup runs the
backup on all clients in the class.

- s schedule
Names the schedule to use for the backup. If it is not specified, the
NetBackup server uses the first user backup schedule it finds for the
client in the class it is using (see the - ¢ option).

- S master_server [, master_server,. . . ]
Specifies the name(s) of the NetBackup master server(s). The default is
the server designated as current on the Servers tab of the Specify
NetBackup Machines dialog box. To display this dialog box, start the user
interface on the client and click Specify NetBackup Machines on the
Actions menu.

-t class_type
Specifies one of the following numbers corresponding to the class type
(the default is 0 on all clients except Apollo, where the default is 3):

0 = Standard

4 = Oracle

6 = Informix-On-BAR
7 = Sybase

10 = NetWare

13 = MS-Windows-NT
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14 =0S/2

15 = MS-SQL-Server

16 = MS-Exchange-Server
19 =NDMP

Note The following class types (Apollo-wbak, DataTools-SQL-BackTrack,
Auspex-FastBackup, SAP, DB2, FlashBackup, Split-Mirror, and AFS) apply only to
NetBackup DataCenter.

3 = Apollo-wbak

11 = DataTools-SQL-BackTrack
12 = Auspex-FastBackup

17 =SAP

18 =DB2

20 = FlashBackup

21 = Split-Mirror

22 = AFS

-L progress_log

Specifies the name of an existing file in which to write progress
information.

For example: ¢: \ pr ogl og
The default is to not use a progress log.

-w [ hh: mm: ss]

Causes NetBackup to wait for a completion status from the server before
returning you to the system prompt.

You can optionally specify a wait time in hours, minutes, and seconds.
The maximum wait time you can specify is 23:59:59. If the wait time
expires before the backup is complete, the command exits with a timeout
status. The backup, however, still completes on the server.

If you use - wwithout specifying a wait time or you specify a value of 0,
NetBackup waits indefinitely for the completion status.

If you include - i with - w NetBackup waits until all initiated jobs have
completed before returning status. However, if more than one job starts,
the status is unpredictable. If the multiple jobs are due to there being
more than one client and the class does not have Allow Multiple Data
Streams selected, you can include the - h option to restrict the operation
to one client and obtain predictable status. However, if the class has
Allow Multiple Data Streams selected and there is more than one job
from the selected client, the status is still unpredictable.
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-hel p Displays a synopsis of command usage when it is the only option on the
command line.

-k keyword _phrase
Specifies a keyword phrase that NetBackup associates with the image
being created by this backup operation. You can then restore the image by
specifying the keyword phrase with the - k option on the bpr est or e
command.

If you use the - i option with - k, NetBackup establishes an association
between the keyword phrase and the backup class and image.

The keyword phrase is a textual description of the backup that is a
maximum of 128 characters in length. All printable characters are
permitted including space (" ") and period ("."). Enclose the phrase in

double quotes ("...") or single quotes ( “...").
The default keyword phrase is the null (empty) string.

-f  listfile
Specifies a file (listfile) containing a list of files to be backed up. This
option can be used instead of the filenames option, but cannot be used
with the - i option. List each file on a separate line.
The format required for the file list depends on whether the files have
spaces or returns in the names.
To back up files that do not have spaces or returns in the names, use this
format:
filepath
Where filepath is the path to the file you are backing up. For example:
c:\ Prograns
c:\wi nnt
c:\docunent s\ ol d_nenos
To back up files that have spaces or returns in the names, use this format:
filepathlen filepath
Where filepath is the path to the file you are backing up and filepathlen is
the number of characters in the file path.
For example:
11 c:\ Prograns
8 c:\w nnt
22 c:\docunents\ol d menos

filenames

Names one or more files to be backed up. This option can be used instead
of the - f option, but cannot be used with the - i option. Any files that
you specify must be listed at the end, following all other options.
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EXAMPLES

EXAMPLE 1
To perform a user backup of a single file, enter:

bpbackup c:\users\user1\filel

EXAMPLE 2

The following command starts a user backup of the files that are listed in a file named
backup_|i st.

bpbackup -f backup_Ii st

EXAMPLE 3

The following command (all on one line) starts an immediate-manual backup of the client
host named diablo, in the class named cis_co. The class type is Standard class and is in the
configuration on the master server named hoss. The progress log is ¢c: \ hone\ hr p\ pr og.

bpbackup -C cis_co -i -h diablo -S hoss -t 0 -L c:\hone\hrp\prog

EXAMPLE 4

The following command (all on one line) associates the keyword phrase "Backup My
Home Directory 01/01/97" to the user backup of the directory c: \ hone\ kwc . The
progress log is ¢: \ horre\ kwe\ bkup. | og.

bpbackup -k "Backup My Honme Directory 01/01/97" -L
c: \ hone\ kwe\ bkup. | og c:\ hone\ kwe
EXAMPLE 5

The following command (all on one line) associates the keyword phrase "Class Win NT
01/01/97" to the immediate-manual backup of the client host named slater in the class
named win_nt_class. The progress log is c: \ t np\ bkup. | og.

bpbackup -k "Class Wn NT 01/01/97" -i -h slater -c win_nt_class -t
13 -L c:\tnp\bkup.!og

FILES

install_path\ Net Backup\ | ogs\ bpbackup\ *. | og
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bplist

NAME

bplist - lists backed up and archived files on the NetBackup server

SYNOPSIS

install_path\ Net Backup\ bi n\bplist [-A| -B] [-C client] [-S
master_server] [-t class type] [-k class] [-F] [-R[n]] [-b
| -c | -u] [-I] [-r] [-Listseconds] [-T] [-unix files]
[-nt_files] [-s mm/dd/yy [hh: mm:ss]] [-e mm/ddlyy
[hh:mm:ss]] [I] [PI] [-hel p] [-keyword "keyword phrase"]
[ filename]

DESCRIPTION

bpl i st shows a list of previously archived or backed up files according to the options
that you specify. You can choose the file or directory and the time period that you want the
listing to cover. Directories can be recursively displayed to a specified depth.

The list shows only the files that you have read access to. You also must own or have read
access to all directories in the file paths. You can list files that were backed up or archived
by another client only if you are validated to do so by the NetBackup administrator.

If you create directory install_path\ Net Backup\ | ogs\ bpl i st\ with write access,
bpl i st creates an activity log file in this directory that you can use for troubleshooting.

The output of bpl i st goes to standard output.

OPTIONS

-A | -B Specifies whether to produce the listing from archives (- A) or backups
(- B). The default is - B.

- C client Specifies a client name to use for finding backups or archives to list. This
name must be as it appears in the NetBackup configuration. The default
is the current client name.

- S master_server
Specifies the name of the NetBackup server. The default is the server
designated as current on the Servers tab of the Specify NetBackup
Machines dialog box. To display this dialog box, start the user interface
on the client and click Specify NetBackup Machines on the Actions menu.

-t class_type
Specifies one of the following numbers corresponding to the class type
(the default is 0 on all clients except Apollos, where it is 3):

0 = Standard
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4 = Oracle

6 = Informix-On-BAR

7 = Sybase

10 = NetWare

13 = MS-Windows-NT
14 =0S/2

15 = MS-SQL-Server

16 = MS-Exchange-Server
19 = NDMP

Note The following class types (Apollo-wbak, DataTools-SQL-BackTrack,
Auspex-FastBackup, SAP, DB2, FlashBackup, Split-Mirror, and AFS) apply only to
NetBackup DataCenter.

-k class

-F

-R [n]

-b | -c|

3 = Apollo-wbak

11 = DataTools-SQL-BackTrack
12 = Auspex-FastBackup

17 =SAP

18 =DB2

20 = FlashBackup

21 = Split-Mirror

20 = AFS

Names the class to search to produce the list. If not specified, all classes
are searched.

Specifies that in the list output, symbolic links (applies only to UNIX
clients) will end with a trailing @ and executable files with a trailing *.

Recursively lists subdirectories encountered to a depth of n. The default
for n is 999.
-u
Specifies an alternate date and time to be used for printing with the - |
option:
- b displays the backup date and time of each file.
- ¢ displays the last modification date and time for each file.
- u displays the last access date and time of each file.
The default is to display the time of last modification of each file.

Showvs file details.
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- Li st seconds

Specifies that seconds granularity be used for the time stamp when the
the - 1 option is used.

-r Lists disk images that were backed up. The default is to list file systems.

-T Lists directories in true-image backups. The default is to list
non-true-image backups.

-unix_files
Lists the files and directories in UNIX format. For example:
| Cl users/test.

-nt_files
Lists the files and directories in Windows NT/2000 format. For example:
C:\users\test.

-s mm/ dd/ yy [ hh: mm: ss]

-e mm/ dd/ yy [ hh: mm:ss]
Specifies the start and end date range for the listing.
- s specifies a start date and time for the listing. The resulting list shows

only files in backups or archives that occurred at or after the specified
date and time. Use the following format for the start date and time:

mm/dd/yy [hh[:mm[:ss]]]

The valid range of dates are from 01/01/70 00:00:00 to 01/19/2038
03:14:07. The default is the current date minus six months.

- e specifies an end date and time for the listing. The resulting list shows
only files from backups or archives that occurred at or before the
specified date and time. Use the same format as explained above for start
date and time. The default is the current date and time.

-1 Specifies a case-insensitive search. This means that capitalization is not
considered when comparing names (for example, Cat matches cat).

-PI Specifies a path-independent search, which means that NetBackup
searches for a specified file or directory without regard to the path. For
example, if a file named t est exists in the three directories shown below,
a search for t est finds all three instances of the file:

/tnp/junk/test
[ abc/ 123/ xxx/ t est

[ abc/ 123/ xxx/ yyyl zzz/ t est

-hel p Displays a synopsis of command usage when it is the only option on the
command line.
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- keywor d " keyword_phrase"
Specifies a keyword phrase for NetBackup to use when searching for
backups or archives from which to restore files. The phrase must match
the one that was previously associated with the backup or archive by the
- k option of the bpbackup or bpar chi ve command.

You can use this option in place of or in combination with the other
restore options in order to make it easier to restore your backups and
archives. The following meta characters can be used to simplify the task
of matching keywords or parts of keywords in the phrase:

* matches any string of characters.
? matches any single character.

[ 1 matches one of the sequence of characters specified within the
brackets.

[ - ] matches one of the range of characters separated by the "-".

The keyword phrase can be up to 128 characters in length. All printable

characters are permitted including space (" ") and period ("."). The phrase

must be enclosed in double quotes ("...") or single quotes (..." ).
The default keyword phrase is the null (empty) string.

filename  Names the file or directory to list. If you do not specify a path, the default
is the current working directory.

Any files that you specify must be listed at the end, following all other
options.

Use upper case for the drive letter. For example, C. \ Net Backup\ | ogl.
EXAMPLES

EXAMPLE 1
To list recursively, in long format, the files that were backed up in D: \ W5_FTP. LOG
bplist -1 D:\W5_FTP. LOG

-TWK------ bj m bj m 64 Oct 10 1997 D:\Ws_FTP. LOG
STWK---- - - bj m bj m 64 Oct 10 1997 D:\WS_FTP. LOG
STWK---- - - bj m bj m 64 Oct 10 1997 D:\WS_FTP. LOG
EXAMPLE 2

To list, with details, the files that were backed up and associated with all or part of the
keyword phrase

"My Honme Directory”
in directory C: \ home\ kwe, enter the following:

bplist -keyword "*My Hone Directory*" -1 C:\home\kw
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EXAMPLE 3

To list, with details, the files that were archived and associated with all or part of the
keyword phrase

"My Honme Directory”
in directory C: \ hone\ kwe enter the following:
bplist -A -keyword "*My Hone Directory*" -I C:\hone\kwc

EXAMPLE 4

To list, recursively and with details, the files that were backed up on drive D of Windows
NT client slater and associated with all or part of the keyword phrase

"Win NT"
enter the following:
bplist -keyword "*Wn NT*" -C slater -t 13 -R -1 D:\

FILES
install_path\ Net Backup\ | ogs\ bplist\*. 1 og
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bprestore

NAME

bprestore - restores files from the NetBackup server

SYNOPSIS
install_path\ Net Backup\ bi n\ bprestore [-A| -B] [-K] [-] | -H| -vVy]
[-r] [-T] [-L progress_log] [-R rename_ file] [-C client] [-D
client] [-S master_server] [-t class_type] [-c class] [-s
mm/ dd/ yy [ hh: mm: ss]] [-e mm/dd/yy[ hh: mm:ss]] [-w
[ hh: mm:ss]] [-k "keyword phrase"] -f Ilistfile | filenames
DESCRIPTION

bpr est or e lets users restore a backed up or archived file or list of files. You can also
name directories to restore. If you include a directory name, bpr est or e restores all files
and subdirectories of that directory.

By default, you are returned to the system prompt after bpr est or e is successfully
submitted. The command works in the background and does not return completion status
directly to you. The - woption lets you change this behavior so bpr est or e works in the
foreground and returns completion status after a specified time period.

The bpr est or e command restores the file from the most recent backups within the time
period you specify, except for a true-image restore (see the - T option description).”

. bpr est or e overwrites any file of the same name that already exists on the local client
disk, unless you include the - K option. It is also possible to restore files that were backed
up or archived on another client (- Coption). You must be validated by the NetBackup
administrator to restore from other clients.

Use the bpl i st command to display information on the files and directories that were
backed up or archived.

bpr est or e writes informative and error messages to a progress-log file if you create the
file prior to the execution of the bpr est or e command and then specify the file with the
- L progress_log option. If bpr est or e cannot restore the requested files or directories,
you can use the progress log to find the reason for the failure.

For detailed troubleshooting information, create a directory named
install_path\ Net Backup\ | ogs\ bpr est or e with write access. bpr est or e then creates
an activity log file in this directory.

The following restrictions apply to bpr est or e:

O You can restore files and directories that you own and those owned by other users if
you have read access. You need write access to another user’s directories and files to
restore that user’s files to their original location.

- 10
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O The operating system restricts the number of files and directories that you can specify
on asingle bpr est or e command line. If this is a problem, use the - f option to
restore the files.

OPTIONS
-A | -B Specifies whether to restore from archives (- A) or backups (- B). The
default is - B.
-K Specifying this option causes bpr est or e to keep existing files rather

than writing over them when restoring files with the same name. The
default is to overwrite existing files.

Note The-1 | -H] -y options apply only when restoring UNIX files to a UNIX system.

1] -H -y
Specifying - | renames the targets of UNIX links by using the - R
rename_file option in the same way as when renaming files.

Specifying - H renames UNIX hard links by using the - Rrename_file
option in the same way as when renaming files. Soft links are unchanged.

Specifying - y renames UNIX soft links by using the - Rrename_file
option in the same way as when renaming files. Hard links are
unchanged.

See Example 5 in the EXAMPLES section.
-r Specifying this option restores disk images instead of file systems.

- L progress_log
Specifies the name of an existing file in which to write progress
information.

For example: c: \ pr ogl og
The default is to not use a progress log.
- Rrename_file
Specifies the name of a file with name changes for alternate-path restores.
For example: bprestore -R /C/renanmefile /Corigfile

Where / C/ renane_fil e is the file with the name change and
[ C origfil eisthefile to be renamed.

Use the following form for entries in the rename file:
change backup_filepath t o restore_filepath

Where:

The file paths must start with / (slash)

The first backup_filepath that is matched is replaced with the
restore_filepath string. The default is to restore using the original path.
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- C client

- D client

For example, the following entry renames C: \ user s\ fred to
C:\users\fred2:

change /Clusers/fred to /Cusers/fred2
(be sure to end the entry with a return)

When restoring to a Windows NT/2000 client, you can also use the
following method for specifying entries in the rename file (do not use this
method for other clients):

renane bulength backup_filepath reslength restore_filepath
Where:

bulength is the number of ASCII characters in the backup path.
reslength is the number of ASCII characters in the restore path.

The first backup_filepath that is matched is replaced with the
restore_filepath string.

For example, the following entry renames C: \ fr ed. t xt to
C\fred2. txt:

rename 11 /C/fred.txt to 12 /C/ fred2.txt

(be sure to end the entry with a return)

Specifies a client name to use for finding backups or archives from which
to restore files. This name must be as it appears in the NetBackup catalog.
The default is the current client name.

Specifies a destination client. This can be done by an administrator on the
master server in order to direct the restored files to a machine other than
the client specified with the - C option.

- S master_server

Specifies the name of the NetBackup server. The default is the server
designated as current on the Servers tab of the Specify NetBackup
Machines dialog box. To display this dialog box, start the user interface
on the client and click Specify NetBackup Machines on the Actions menu.

-t class_type

Specifies one of the following numbers corresponding to the class type
(the default is 0 on all clients except Apollos, where it is 3):

0 = Standard

4 = Oracle

6 = Informix-On-BAR
7 = Sybase

10 = NetWare

13 = MS-Windows-NT
14 =0S/2
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15 = MS-SQL-Server
16 = MS-Exchange-Server
19 = NDMP

Note The following class types (Apollo-wbak, DataTools-SQL-BackTrack,
Auspex-FastBackup, SAP, DB2, FlashBackup, Split-Mirror, and AFS) apply only to
NetBackup DataCenter.

3 = Apollo-wbak

11 = DataTools-SQL-BackTrack

12 = Auspex-FastBackup

17 =SAP

18 =DB2

20 = FlashBackup

21 = Split-Mirror

20 = AFS
- C class Specifies the class for which the backups or archives were performed.
-s mm/ dd/ yy [ hh: mm: ss]

-e mm/ dd/ yy [ hh: mm: ss]
Specifies the start and end date range for the listing. The bpr est or e
command restores only files from backups or archives that occurred
within the specified start and end date range.

- s specifies a start date and time for the restore window. bpr est or e
restores files only from backups or archives that occurred at or after the
specified date and time. Use the following format:

mm/dd/yy [hh[:mm[:ss]]]

The valid range of dates are from 01/01/70 00:00:00 to 01/19/2038
03:14:07. The default start date is 01/01/70 00:00:00.

- e specifies an end date and time for the restore window. bpr est or e
restores only files in backups or archives that occurred at or before the
specified date and time. Use the same format as for the start date and
time.

The end backup date and time do not need to be exact, except for a
true-image restore (see the - T option description). The bprestore
command restores the file that has the specified backup date and time or
the file that is the most recent backup preceding the end date and time.
The default is the current date and time."

If you do not specify either - s or - e, bpr est or e restores the most
recently backed up version of the file.
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Specifies a true-image restore, where only files and directories that
existed in the last true-image backup are restored. This option is useful
only if true-image backups were performed. If this option is not specified,
all files and directories meeting the specified criteria are restored, even if
they were deleted.

When the - T option is specified, the image requested must be uniquely
identified. Unique identification is accomplished by using the - e option
with seconds granularity. The - s option, if any, is ignored. The seconds
granularity of an image can be retrieved by using the bpl i st command
with the -1 and - Li st seconds options.

-w [ hh: mm: ss]

Causes NetBackup to wait for a completion status from the server before
returning you to the system prompt.

You can optionally specify a wait time in hours, minutes, and seconds.
The maximum wait time you can specify is 23:59:59. If the wait time
expires before the restore is complete, the command exits with a timeout
status. The restore, however, still completes on the server.

Specifying 0 or not specifying a time, means wait indefinitely for the
completion status.

-k "keyword_phrase"

-f

listfile

Specifies a keyword phrase for NetBackup to use when searching for
backups or archives from which to restore files. The phrase must match
the one that was previously associated with backup or archive by the - k
option of the bpbackup or bpar chi ve command.

You can use this option in place of or in combination with the other
restore options in order to make it easier to restore your backups and
archives. The following meta characters can simplify the task of matching
keywords or parts of keywords in the phrase:

* matches any string of characters.
? matches any single character.

[ 1 matches one of the sequence of characters specified within the
brackets.

[ - ] matches one of the range of characters separated by the "-".

The keyword phrase can be up to 128 characters in length. All printable

characters are permitted including space (" ") and period ("."). The phrase
must be enclosed in double quotes ("...") or single quotes ("...").

The default keyword phrase is the null (empty) string.

Specifies a file (listfile) containing a list of files to be restored and can be
used instead of the filenames option. In listfile, list each file path on a
separate line.
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The format required for the file list depends on whether the files have
spaces or newlines in the names.

To restore files that do not have spaces or newlines in the names, use this
format:

filepath
Where filepath is the path to the file that you are restoring. For example:

Note Use upper case for the drive letter. For example, C: \ Net Backup\ Log1.

C.\ prograns
C.\'wi nnt
C.\docunent s\ ol d_nenos

To restore files that have spaces or newlines in the names, use one of the
following formats:

filepathlen filepath

filepathlen filepath start_date_time end_date_time
filepathlen filepath - s datetime - e datetime

Where:

filepath is the path to the file you are restoring.

filepathlen is the total number of characters in the file path.

start_date_time and end_date_time are the decimal number of seconds
since 01/01/70 00:00:00.

datetime is the same as the command line (mm/ dd/ yy [hh[: mm[: ss]]]).
The start and end date and time specified on the command line is used
unless a line in listfile overrides it. The dates may change from line to line.

The following is an example that uses filepathlen filepath:
11 C:\ prograns
8 C:\w nnt
22 C.\docunents\old nenos
filenames Names one or more files to be restored and can be used instead of the - f
option.
Any files that you specify must be listed at the end, following all other
options. You must also specify absolute file paths.
Use upper case for the drive letter. For example, C: \ Net Backup\ | ogl.
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EXAMPLES

EXAMPLE 1

To restore a file from backups of C:\user 1\ fi | el that were performed between
04/01/93 06:00:00 and 04/10/93 18:00:00, enter the following (all on one line):

bprestore -s 04/01/93 06: 00: 00 -e 04/10/93 18:00: 00 C \useril\filel

EXAMPLE 2

To restore files listed in a file named r est or e_I| i st by using the most recent backups,
enter the following:

bprestore -f c:\restore_|ist

EXAMPLE 3

To restore the directory C: \ kwe from the backups that are associated with a keyword
phrase that contains "My Home Directory" and use a progress log hamed
d: \ kwe\ bkup. | og, enter the following (all on one line):

bprestore -k "*My Home Directory*" -L d:\kwc\bkup.log C\kwe

EXAMPLE 4

To restore the D drive on the Windows NT client slater from the backups that are
associated with a keyword phrase that contains "My Home Dir" and use a progress log
named c: \ kwe\ bkup. | og, enter the following (all on one line):

bprestore -k "*My Home Dir*" -C slater -D slater -t 13 -L
c:\kwe\ bkup.log D:\
EXAMPLE 5

Assume you have a rename file named / hone/ kwe/ r enane on a UNIX client and it
contains the following:

change /home/ kwe/ i nkback to /home/ kwe/ | inkback_alt

To restore the hard link named / home/ kwe/ | i nkback to alternate path
/ horme/ kwe/ | i nkback _al t on that client, execute:

bprestore -H -R /home/ kwe/ rename [/ hone/ kwe/ i nkback

FILES
install_path\ Net Backup\ | ogs\ bprestore\*. 1 og
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Glossary

access control list (ACL)

Security information associated with files on some file systems.

ACS
Automated Cartridge System. This robot type is supported only by NetBackup
DataCenter servers.

active job

A job for which NetBackup is currently processing backup or restore data.

activity logs
Logs that can be optionally enabled for specific NetBackup programs and processes and
then used to investigate problems.

activity monitor
A NetBackup administration utility that displays information about NetBackup jobs and
provides limited control over them.

administrator
A user that is granted special privileges to install, configure, and manage the operation of
a system, network, or application

administration client
A Windows NT/2000 NetBackup client that has the administration interface software
installed and can be used to administer NetBackup servers.

AIT
Sony Advanced Intelligent Tape, a type of tape drive or media type.
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alternate-client restore

Restoring files to your client when they were originally backed up from a different client.
The administrator using the interface on the master server can direct a restore to any client
(this variation is called a server directed restore).

alternate-target restore

On a Novell NetWare server platform running the NetBackup target version of client
software, this operation restores files to a different target than the one from which they
were backed up.

alternate path restore

Restores files to a different directory than the one from which they were backed up.

archive
A special kind of backup where NetBackup backs up the selected files, and if the backup
is successful, deletes the files from the local disk. In this manual, references to backups
also apply to the backup portion of archive operations except where otherwise noted.
archive bit

A file-status bit that the Microsoft based operating system sets when it writes a file,
thereby indicating that the file has changed.

attributes for a class
Configuration parameters that control the behavior of NetBackup during operations
involving this class.

automatic backup

A scheduled backup by the master server.

back up
The act of copying and saving files and folders to storage media.

backup
Refers to the process of copying and saving files and directories to storage media. For
example, the backup is complete. This term can also refer to the collection of data that
NetBackup saves for a client during a backup or archive. For example, duplicate the backup.
Backup is two words when used as a verb. For example, back up the file.
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backup, archive, and restore interface

The name of the NetBackup Microsoft Windows and Java based user interfaces for clients.
On servers, these interfaces can be started through the NetBackup Administration
interface.

backup window

block size

The period of time during which backups can begin.

The number of bytes in each block of data written on the media during a backup.

bp
A backup, archive, and restore utility for users on NetBackup UNIX clients. It has a
character-based, menu interface that can be run from terminals that do not have X
Windows capabilities.

bpadm
An administrator utility that runs on NetBackup UNIX servers. It has a character-based,
menu interface that can be run from terminals that do not have X Windows capabilities.

bp.conf file
A NetBackup configuration file on UNIX servers and also on UNIX, Macintosh, and OS/2
clients.

bp.ini file
NetBackup initialization file for Novell NetWare target clients.

bpcd
NetBackup Client service on Windows NT/2000 and the NetBackup Client daemon on
UNIX.

bprd
NetBackup Request Manager service on Windows NT/2000 and NetBackup Request
daemon on UNIX.

catalogs
Internal NetBackup and Media Manager databases. These catalogs contain information
about configuration, media, devices, status, errors, and the files and directories in the
stored backup images.

Glossary
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CDF

Context-dependent file, which is a type of directory structure on a Hewlett-Packard

system.

class
Defines the backup policy for a group of one or more clients that have similar backup
requirements.

client

The system with the files to back up, archive, or restore.

client-user interface

The program used to perform user backups, archives, and restores.

cluster

See master and media server cluster.

command lines

Commands that users can execute either from the system prompt or in scripts.

compression

The process of compacting data to enable more efficient transmission and storage.

configuration
The parameters that govern the behavior of an application. This term can also refer to the
manner in which a network or system is laid out or connected (for example, a network
configuration).

cpio
A UNIX command for formatting data on a tape.

ctime

The time that a UNIX inode was changed.

cumulative-incremental backup

A backup that is scheduled by the administrator on the master server and backs up files
that have changed since the last successful full backup. All files are backed up if no prior
backup has been done. Also see “differential-incremental backup.”
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daemon

A program on a UNIX system that runs in the background and performs some task (for
example, starting other programs when they are needed). Daemons are generally referred
to as services or processes on Windows NT/2000 systems.

database-agent clients
Clients with additional NetBackup software that is designed to back up relational
databases.

database-extension clients

See “database-agent clients.”

debug logs

See “activity logs.”

device delays
Delays caused by the device that are beyond the control of the storage application. An
example is the time required to position tape under the read and write heads.

device host

A Media Manager host where a drive or robotic control is attached or is defined.

device monitor

A Media Manager administration utility that provides monitoring and manual control of
Media Manager storage devices. For example, an administrator or computer room
operator can use this utility to manually reset devices or set them to the UP or DOWN
state.

DHCP
Dynamic host configuration protocol. This TCP/IP protocol automatically assigns
temporary IP addresses to hosts when they connect to the network.
differential-incremental backup

Scheduled by the administrator on the master server and backs up files that have changed
since the last successful incremental or full backup. All files are backed up if no prior
backup has been done. Also see “cumulative-incremental backup.”

directory depth

The number of levels below the current directory level that the NetBackup interfaces
show in their directory and file list displays.
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directory tree

The hierarchical structure in which files are organized on a disk. Each directory lists the
files and directories that are directly below it in the tree. On UNIX, the topmost directory
is called the root directory.

disaster recovery

Recovering data from backups after a disk crash or other catastrophe.

disk

Magnetic or optical disk storage media.

disk-image backup
A bit-by-bit rather than a file system backup of a disk drive on Windows NT/2000.

DLT

Digital-linear tape or tape drive type.

Domain Name Service (DNS)

A program that handles name translation for network communications.

drive cleaning

The use of a special cleaning tape to clean the heads on a drive.

duplicate image

A copy of a backup image.

encryption

Provides additional security by encrypting backup data on the client. This capability is
available only with the NetBackup Encryption option.

entry and exit ports

A slot or other opening in a robot where you can insert or remove a tape without having
to access the interior of the robot. After inserting a tape, you move it to a slot by using an
inject command. Prior to removing a tape, you move it to the port by using an eject
command. The inject and eject commands are supported through the add and move
screens in the Media Manager administration interface. Entry and exit ports are
sometimes called mailslots, or inports and outports.
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exclude list

A list that designates files or directories to exclude from automatic backups.
expiration (image)

The date and time when NetBackup stops tracking a backup image.

expiration (volume)

The date and time when the physical media (tape) is considered to be no longer usable.

EVSN
External volume serial number. This is an identifier written on a media cartridge or
canister so the operator can identify the volume before inserting it into a drive or robot.
For labeled media, the EVSN must be the same as the RVSN (identifier recorded on the
media). For all media, the EVSN is the same as the media ID.

FastBackup

A special type of raw-partition backup that can be performed only on an Auspex client
(this option is available only for NetBackup DataCenter).

FlashBackup

A special type of raw-partition backup that requires the NetBackup FlashBackup
separately-priced option (this option is available only for NetBackup DataCenter).

flush level
Controls how often Netbackup clears its log files on a Novell NetWare or Microsoft
Windowvs client platform.

fragment
A part of a backup or archive image. NetBackup can be configured to divide images into
fragments when they exceed a certain size or span tapes.

frequency (backup)
How often NetBackup performs scheduled backups. For example, if the frequency is
seven days then backups occur once a week.

FROZEN media state

If a volume is FROZEN, NetBackup keeps it indefinitely and can restore from it but not
use it for further backups or archives.
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full backup
A backup that copies, to a storage unit, all files and directories that are beneath a specified
directory.

FULL media state
If this appears in a report or listing, it indicates the volume is FULL and cannot hold more
data or be used for further backups.

global attributes

NetBackup configuration attributes that affect all classes.

Global Data Manager

A separately-priced option (for UNIX servers) that provides an interface with a tree view
where the administrator can view and administer multiple master servers. The server
where the option is installed is called a Master of Masters.

GNU tar

A public domain version of the UNIX tar program.

goodies directory

A directory containing programs, scripts, and other files that are not formally supported.

gravity stacker

A robot that relies on gravity to advance to the next required tape.

GUI
Graphical user interface.

hard link
On UNIX, a hard link is a pointer to the inode for the data. On Windows NT/2000 a hard
link is a directory entry for a file. Every file can be considered to have at least one hard
link. On NTFS volumes each file can have mulitple hard links, and a single file can appear
in many directories (or even in the same directory with different names).

heap level
A parameter for memory-heap debugging on a Novell NetWare or Windows NetBackup
client.
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hierarchical storage management

The process of automatically migrating selected files from a managed file system to
specified migration levels on secondary storage, while maintaining transparent access to

those files.
host
A computer that executes application programs.
host name
Name by which a host computer is identified by programs and other computers in the
network.
HSM
See storage migrator.
image
The collection of data that NetBackup saves for an individual client during each backup or
archive. The image contains all the files, directories, and catalog information associated
with the backup or archive.
import
The process of recreating NetBackup records of images so the images can be restored.
include list

A list that designates files or directories to add back in from the exclude list.

incremental backup

See “cumulative-incremental backup” and “differential-incremental backup.”

inport

See “entry and exit ports.”
inode

A UNIX data structure that defines the existence of a single file.
install_path

Directory where NetBackup and Media Manager software is installed. The default on
Windows NT/2000 is C: \ Program Fi | es\ VERI TAS and on UNIX itis/ usr/ openv.
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jbpSA

jnbSA

job

kernel

The Java-based NetBackup interface for performing user backups, archives, and restores.

The Java-based NetBackup interface for administrators.

A parcel of work submitted to a computer. NetBackup jobs are backups, archives, or
restores.

The nucleus of an operating system.

keyword phrase

kill a job

label

library

link

A textual description of a backup.

Terminating a job and removing it from the job queue.

Identifier of a tape or optical disk volume. A recorded label includes a media ID.

A barcode label allows a barcode scanner to be used for media tracking.

Refers to a robot and its accompanying software. A library includes a collection of tapes or
optical platters used for data storage and retrieval. For example, a Tape Library DLT
(TLD) refers to a robot that has TLD robotic control.

See “hard link” or “symbolic link.”

LMF - Library Management Facility

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

wWww. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.
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load

(noun) Amount of work that is being performed by a system or the level of traffic on a
network. For example, network load affects performance.

(verb) Copy data to internal memory. For example, load the installation program.

logs

Files where a computer or application records information about its activities.
mailslot

See “entry and exit ports.”
man pages

Online documentation provided with UNIX computer systems and applications.

Master and media server cluster

A NetBackup master server and the remote media servers that it is using for additional
storage. It is possible to configure clusters only with NetBackup DataCenter servers.
NetBackup BusinesServer supports only a single server, the master.

Master of Masters

A NetBackup host where Global Data Manager software is installed. When logging into
this host, the interface has a tree view where the administrator can view and administer
multiple master servers.

master server

The NetBackup server that provides administration and control for backups and restores
for all clients and servers in a master and media server cluster. NetBackup BusinesServer
supports only a single server and it is the master.

media

Physical magnetic tapes, optical disks, or magnetic disks where data are stored.
media host

NetBackup server to which the job (client) is sending the data.
media ID

An identifier that is written on a volume as part of the recorded label.
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Media Manager
Software that is part of NetBackup and manages the storage devices and removable
media.

Media Manager Host

A host where Media Manager software is installed.

media server

A NetBackup server that provides storage within a master and media server cluster. The
master can also be a media server. A media server that is not the master is called a remote
media server (or slave server). NetBackup BusinesServer does not support remote media
servers.

menu interface

A character-based interface for use on terminals that do not have graphical capabilities.

MHD

See “multihosted drives.”

mount

Make a volume available for reading or writing.

mount point
The point where a file system on a disk logically connects to a system’s directory structure
so the file system is available to users and applications.

MPX

See “multiplexing.”

mtime

The point in time when a UNIX or NTFS file is modified.

multihosted drives

A separately priced VERITAS option (Shared Storage Option or SSO) that allows tape
drives (standalone or in a robotic library) to be dynamically shared among multiple
NetBackup and Storage Migrator servers.

This option is supported only on NetBackup DataCenter servers.
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multiplexing
The process of sending concurrent-multiple backups from one or more clients to a single
storage device and interleaving those images onto the media.

multiplexed group

A set of backups that were multiplexed together in a single multiplexing session.

NDMP
Network data management protocol. NetBackup requires the NetBackup for NDMP
separately-priced option to support NDMP.

NetBackup Client service

NetBackup Windows NT/2000 service that runs on clients and servers and listens for
connections from NetBackup servers and clients in the network. When a connection is
made, this service starts the necessary programs.

NetBackup configuration options

On UNIX servers and on UNIX and Macintosh, clients, these settings are made in the
bp. conf file. On NetWare target and OS/2 clients, they are in the bp. i ni file. On
Windows NT/2000 servers and Microsoft Windows clients, these settings are called
properties and are made through the Backup, Archive, and Restore interface or the
Configure - NetBackup window in the administration interface.

NetBackup databases

See catalogs.

NetBackup Database Manager service

NetBackup Windows NT/2000 service that runs on the master server and manages the
NetBackup internal databases (called catalogs). This service must be running on the
master server during all NetBackup administrative operations.

NetBackup Device Manager service

The NetBackup Windows NT/2000 service that runs on a NetBackup server and starts the
robotic control processes and controls the reservation and assignment of volumes. This
service runs only if the server has devices under Media Manager control. The process is
[tid.

NetBackup properties

Same as NetBackup configuration options but are called NetBackup properties on
Microsoft Windows platforms.
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NetBackup Request Manager service
The NetBackup Windows NT/2000 service that runs on the master server and starts the
scheduler and receives requests from clients.

NetBackup Volume Manager service

A NetBackup Windows NT/2000 service that runs on a NetBackup server, allows remote
administration of Media Manager, and manages volume information. The process is vird.

NIS

Network information service.
NLM

NetWare loadable module.
NFS

Network file system.
nonrobotic

See “standalone.”
ODL

Optical disk library. This robot type is supported only by NetBackup DataCenter servers.

OSF and Motif

A set of specifications for user-interface design.

outport
See “entry and exit ports.”
partitions
The logical partitions into which a magnetic disk is divided.
patch
A program that corrects a problem or adds a feature to an existing release of software.
path length
Number of characters in a pathname.
N A _ R
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pathname

The list of directories in the path to a destination directory or file.

PC clients
NetBackup clients that have Microsoft Windows (NT/2000, 98, 95), Macintosh, or IBM
0OS/2 operating systems.

peername
The name by which a computer identifies itself when establishing connections to other
systems.

port

A location used for transferring data in or out of a computer.

primary copy
The copy of an image that NetBackup uses to satisfy restores. When NetBackup duplicates
an image, the original is designated as the primary copy.

privileges

The tasks or functions that a user, system, or application is authorized to perform.

progress report

Log where NetBackup records events that occur during user operations.

proxy restore

A proxy restore allows the user to restore files, that he has write access to, on a machine
other than his desktop. The files must be in a backup of the machine to which they are
being restored.

QIC

Quarter-inch-cartridge tape.

queued job

A job that has been added to the list of jobs to be performed.

raw-partition backup

Bit-by-bit backup of a partition of a disk drive on UNIX. On Windows NT/2000, this is
called a disk-image backup.
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rbak

The program that Apollo clients use to read data from tape during a restore.

registry
A Microsoft Windows 2000, NT, 98, and 95 database that has configuration information
about hardware and user accounts.

remote media server

A media server that is not the master. Note that only NetBackup DataCenter supports
remote media servers. NetBackup BusinesServer supports only a single server, the master.

residence
In Media Manager, information about the location of each volume is stored in a volume
database. This residence entry contains information, such as robot number, robot host,
robot type, and media type.

resource
A Novell NetWare term that refers to a data set on the target. For example, in DOS,
resources are drives, directories, and files. Also see “target service.”

restore

(verb) The act of restoring selected files and directories from a previous backup or archive
and returning them to their original directory locations (or to an alternate directory).

(noun) The process of restoring selected files and directories from a previous backup and
returning them to their original directory locations (or to an alternate directory).
retention level

An index number that corresponds to a user-defined retention period. There are 10 levels
from which to choose (0 though 9) and the retention period associated with each is
configurable. Also see “retention period.”

retention period

The length of time that NetBackup keeps backup and archive images. The retention
period is specified on the schedule.

root
The highest level directory in a hierarchical directory structure. In MS-DOS, the root
directory on a drive is designated by a backslash (for example, the root on drive C is C:\).
On UNIX, the root directory is designated by a slash (/).
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Also, a UNIX user name having administration capability.

RS-232
An industry-standard interface for serial communications and sometimes used for
communicating with storage peripherals.

RSM Interface
Application in Windows 2000 used to manage Removable Storage Manager (RSM)
devices.

RSM - Removable Storage Manager

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

wWwWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

Also, a component of the Windows 2000 operating system that manages storage devices.

RVSN
Recorded volume serial number. This is an identifier recorded as part of the label on a
volume and used by Media Manager to ensure that the correct volume is mounted. The
RVSN is the same as the media ID.

schedules
Controls when backups can occur in addition to other aspects of the backup, such as: the
type of backup (full, incremental) and how long NetBackup retains the image.

SCSI

Small computer system interface. This is a type of parallel interface that is frequently used
for communicating with storage peripherals.
slave server

See Remote media server.

server directed restore
Using the client interface on the master server to restore files to any client. Only the
administrator can perform this operation.

server independent restore

Restoring files by using a NetBackup server other than the one that was used to write the
backup. This feature is available only with NetBackup DataCenter.
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server list

service

session

The list of servers that a NetBackup client or server refers to when establishing or
verifying connections to NetBackup servers. On a Windows NT/2000 server and
Microsoft Windows clients, you update the list through a dialog box in the interface. On a
UNIX server and UNIX and Macintosh clients, the listis in the bp. conf file. On NetWare
target and OS/2 clients, the list is in the bp. i ni file.

A program on a Windows NT/2000 system that runs in the background and performs
some task (for example, starting other programs when they are needed). Services are
generally referred to as daemons on UNIX systems.

An instance of NetBackup checking its schedules for backups that are due, adding them to
its worklist, and attempting to complete all jobs in the worklist. For user backups and
archives, a session usually consists of a single backup or archive.

Shared Storage Option (SSO)

SMDR

SMS

standalone

See “multihosted drives.”

Storage management data requestor, a Novell NetWare program that provides its services
transparently to all SMS modules and lets remote and local modules communicate with
one another.

Novell NetWare storage management services.

A qualifier used with drives and media to indicate they are not associated with a robot.
For example, a standalone tape drive is one where you must manually find and insert
tapes before using them. A standalone volume is one that is located in a standalone drive
or is stored outside of a drive and designated as standalone in the volume configuration.

status code

A numerical code, usually accompanied by a message, that indicates the outcome of an
operation.
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storage migrator

Refers to the VERITAS Storage Migrator line of hierarchical storage management products
for UNIX and Windows NT/2000. These products make extra room on a disk by
transparently moving data to other storage and then transparently retrieving the data
when it is needed by a user or application.

Storage Migrator is available only for NetBackup DataCenter servers.

storage unit

Refers to a storage device where NetBackup or Storage Migrator stores files. It can be a set
of drives in a robot or consist of one or more single tape drives that connect to the same
host.

SUSPENDED media state

If a volume is SUSPENDED, NetBackup can restore from it but cannot use it for backups.
NetBackup retains a record of the Media ID until the last backup image on the volume
expires.

symbolic link

On a UNIX system, this is a pointer to the name of the file that has the source data.

tape format

The format that an application uses to write data on a tape.

tape marks

A mark that is recorded between backup images on a tape.

tape overhead
The space required for data that is not part of the backup images. For example, tape marks
and catalogs of what are on the tape are considered overhead.

tape spanning

Using more than one tape to store a single backup image.

tar

Tape ARchive program that NetBackup uses to extract backup images during a restore.

target

See “target service.”
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target service

A Novell NetWare service that needs storage management. The SMS views all services (for
example, print services, communication services, workstations) as targets.

Target Service Agent

A Target-service agent is a Novell NetWare agent that prepares the target’s data for SMS
during a backup and for the target during a restore.

TLD - Tape Library DLT

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

WwWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

TLH - Tape Library Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

WWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

TLM - Tape Library Multimedia

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

W, support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

TL4 - Tape Library 4MM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

WWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

TL8 - Tape Library 8MM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

wWWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

~ 148 NetBackup User’s Guide - Microsoft Windows



timeout period

The period of time that an application has allotted for an event to occur.

TIR

See “true image restore.”

tpconfig

A Media Manager administration utility for configuring devices and is started from the
command line. On UNIX; it has a character-based, menu interface that can be run from
terminals that do not have X Windows capabilities.

transfer rate

The rate at which computer information is transferred between a source and a destination.

true image restore
Restores the contents of a directory to what it was at the time of any scheduled full or
incremental backup. Previously deleted files are ignored.

TS8 - Tape Stacker 8MM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at
wWaWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

TSA

“Target Service Agent.”

TSH - Tape Stacker Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web page at

wWwWw. support . veritas. com Choose NetBackup BusinesServer or NetBackup
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

user operation

A backup, archive, or restore that is started by a person on a client system.

verbose flag

Configuration file entry that causes a higher level of detail to be written in the logs.
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verify

An operation that compares the list of files that are actually on a volume with what
NetBackup has recorded as being on it. The data that is on the media is not verified.

vmadm
A Media Manager administrator utility for managing volumes. It runs on UNIX and has a
character-based, menu interface that can be run from terminals that do not have X
Windows capabilities.
vm.conf
A Media Manager configuration file with entries that include the servers that can manage
local devices and default media ID prefixes for media that do not contain barcodes.
volume

Media Manager volumes are logical units of data storage or cleaning capability on media
that have been assigned media IDs and other attributes, which are recorded in the Media
Manager volume database.

volume configuration

Refers to configuration information that is stored in the Media Manager volume database.

volume database

An internal database where Media Manager keeps information about volumes. All Media
Manager hosts have a volume database. However, the database is empty unless the host is
designated as a volume database host.

volume database host

The Media Manager host that contains information about the volumes that Media
Manager uses in a device. Because NetBackup BusinesServer supports only a single
server, the volume database host is always the Media Manager host.

volume group
A set of volumes that are configured within Media Manager to reside at the same physical
location (for example, in a specific robot).

volume pool

A set of volumes that are configured within Media Manager to be used by a single
application and are protected from access by other applications and users.
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wakeup interval

wbak

The time interval at which NetBackup checks for backups that are due.

The program that Apollo clients use to write data on tape.

wildcard characters

A character that can be used to represent other characters in searches.

WORM media

Write-once, read-many media for optical disks. NetBackup BusinesServer does not
support WORM media.

Windows Display Console

A NetBackup-Java interface program that runs on Windows 2000, NT, 98, and 95
computers. Users and administrators can start this interface on their local system, connect
to a UNIX system that has the NetBackup-Java software installed, and then perform any
user and administrator operations that their permissions allow.

xbp
The X Windows-based backup, archive, and restore program for users on NetBackup
UNIX clients.

xbpadm
The X Windows-based NetBackup administration interface on UNIX. This interface is
available only with NetBackup DataCenter.

xbpmon
The X Windows-based NetBackup utility for monitoring jobs on UNIX. This utility is
available only with NetBackup DataCenter.

xdevadm
The X Windows-based Media Manager utility for managing devices on UNIX. This
interface is available only with NetBackup DataCenter.

xvmadm
The X Windows-based Media Manager utility for managing media on UNIX. This
interface is available only with NetBackup DataCenter.
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